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Overview
The Line Item Modeling solution in OneStream is designed to configure diverse FP&A needs for 

precise line-item planning throughout your organization. The solution empowers users to build 

detailed, driver-based operational plans directly within the OneStream platform. Designed for 

agility, scale, and business ownership, it enables granular modeling across operational domains 

like workforce, sales, capital, and contracts, with full control over logic, security, and performance 

with minimal IT assistance required. The solution leverages formulas and various drivers to 

compute data, which is then presented in structured plans for reporting purposes. It can be used 

independently or combined with other OneStream solutions based on your requirements. This 

solution offers three different configurations depending on your planning needs:

 l Workforce Planning: This configuration aids in workforce budgeting, forecasting, and 

analysis, providing you with an efficient means of managing human resources. The 

Register uses defined start and end dates to perform calculations and includes a built-in 

transfer feature that enables you to manage employee movements across different areas of 

the organization.

 l Fixed Term Planning: This configuration uses defined start and end dates in the Register 

to perform calculations and can be used for date-driven operations that aren't tied to 

specific individuals, such as travel planning, leases, subscriptions, or project planning.

 l Duration Based Planning: This configuration uses a defined start date and duration to 

perform calculations and can be used for duration-driven operations that aren't tied to a 

specific end date, such as project level planning, contracts, grants or other engagements.

NOTE: Line Item Modeling is compatible with the Modern Browser Experience and 

supports all culture code settings.
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Setup and Installation
This section contains important details related to the planning, configuring, and installation of your 

solution. Before you install the solution, familiarize yourself with these details.

See OneStream Solution Modification Considerations.

Dependencies

Component Description

OneStream 9.0.0 or 

later

Minimum OneStream Platform version required to install this 

version of Line Item Modeling.

Microsoft SQL Server 

2017 or later

Line Item Modeling requires an instance of Microsoft SQL Server 

2017 or later.

Load Solution
 1. In the OneStream Solution Exchange, go to OneStream Solutions and select the Line Item 

Modeling tile.

 2. On the Line Item Modeling Solution page, in the Platform Version drop-down menu, 

select the appropriate OneStream Platform version.

 3. In the Solution Version drop-down menu, select the most recent version. Click Download.
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 4. Log into OneStream.

 5. On the Application tab, go to Tools > Load/Extract.

 6. On the Load tab, use the Select File buttons to locate the solution package. Click Open.

 7. When the solution file name appears, click Load.

 8. Click Close to complete.

Install Overview
Welcome to OneStream's Line Item Modeling Installer. This powerful installer offers three 

different configurations to install: Workforce Planning, Fixed Term Planning and Duration Based 

Planning. You can also install multiple instances of the different configurations depending on your 

planning needs.

Once the setup of your configuration type is complete, either by following the Setup Wizard or 

importing a configuration file, a new dashboard is created as the configuration type and instance.

NOTE: You can uninstall an instance on the Welcome Page or while using the setup 

wizard by selecting the Uninstall Full button.

Install Configuration

Use the Line Item Modeling Installer in the OnePlace tab to install a planning configuration.

NOTE: Only OneStream administrators can set up the solution, adjust the settings and 

see the Line Item Modeling solution Installer.
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 1. Go to Dashboards > Line Item Modeling > Line Item Modeling Installer.

 2. Click the Install button below the type of planning configuration you want to install.

 3. In the dialog box, click the PROCEED button.

NOTE: Once the configuration is installed, a new workspace and dashboard are 

created as the configuration type and instance. You may have to refresh the 

application to see the new dashboard on the OnePlace tab.
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 4. On the configuration Welcome Page, click Install Tables.

NOTE: Each install of the configuration options will install in its own schema and 

instance number. For example, Workforce Planning 1.

After tables are installed, you're directed to a welcome page to start your setup. You can either 

use the Setup Wizard or the Configuration option.

Uninstall Installer

To uninstall the Line Item Modeling installer, click the Uninstall Line Item Modeling Installer link 

on the installer welcome page.

IMPORTANT: A dialog box will display to confirm if you want to proceed.

NOTE: Current planning instances will remain installed.
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Instance Manager
The Line Item Modeling Installer includes a centralized Instance Manager capability for  

OneStream administrators. This feature provides a clear and streamlined path to upgrade or 

remove existing instances of planning configurations from a single location, improving 

maintainability and reducing complexity.

To access the Instance Manager page, select the Instance Manager link on the installer 

welcome page.
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Upgrade Instance

As an administrator, you can upgrade planning instances to the latest version from the Instance 

Manager page. This process ensures your planning instance runs on the most current version 

without requiring a full reinstall. The latest version of the solution will be installed on the same 

instance number and carryover the workspace name and profile as well as existing data, 

schemas, and business rules. However, the WorkforcePlanningImportRegisterConnector 

business rule will be overwritten during an upgrade. This connector is customizable based on the 

resource you will need to connect your workforce data if it's coming from another source system. 

Ensure this is saved elsewhere prior to upgrading your instance to ensure its not overwritten. 

Changing the workspace name in Line Item Modeling is not recommended.

IMPORTANT: If upgrading from PV9.0.0 SV1.2.0 to a new version, ensure all business 

rule customizations have been updated to reference LIMXX instead of PLNXX prior to 

upgrading.

IMPORTANT: Any custom changes to standard dashboards, reports, or business rules 

should be saved as renamed or copied objects, as future OneStream solution upgrades 

may overwrite standard objects and remove unsupported customizations.

To upgrade a planning instance, follow the legend and corresponding instructions:
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 1. On the Instance Manager page, select an instance.

 2. Click the Upgrade button.

IMPORTANT: A dialog box will display to confirm if you want to proceed.

After installation is complete, the instance is ready to use without needing to use the setup wizard 

again.

Uninstall Instance

As an administrator, you can uninstall planning instances from the Instance Manager page.

To uninstall a planning instance, follow the legend and corresponding instructions:
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 1. On the Instance Manager page, select an instance.

 2. Click the Uninstall Full or Uninstall UI button.

 l Use the Uninstall Full button to remove all related data tables, data, workspaces 

and workspace components, but retain business rules. The instance is removed from 

the table.

 l Use the Uninstall UI button to remove all dashboards, but retain databases, related 

tables and business rules. The instance name updates to start with Uninstalled.

IMPORTANT: A dialog box will display to confirm if you want to proceed.
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Instance Security

OneStream Administrators can now assign a specific security group to act as the Line Item 

Modeling Solution Administrator for a particular planning instance directly from the Line Item 

Modeling Installer. This allows organizations greater flexibility to delegate administrative 

responsibilities. The Line Item Modeling Solution Administrator  inherits all administrative 

capabilities specific to managing a planning instance such as upgrading the solution, configuring 

it through the Setup Wizard or configuration file, and accessing all Settings dashboards. It's 

recommended to create a dedicated security group for the LIM Solution Administrator assignment 

to prevent unintended access.

NOTE: The Instance Manager does not allow the Line Item Modeling Solution 

Administrator group to be modified until a planning instance has been fully installed, 

including  tables.

To assign an Line Item Modeling Solution Administrator, follow the legend and corresponding 

instructions:
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 1. Select a Planning Instance.

 2. In the LIM Solution Administrator column, double-click on the security group.

 3. In the drop-down menu, select a security group.

 4. Click the Save Security button.

NOTE: When you change the LIM Solution Administrator assignment, the solution 

automatically updates that instance’s Security Actions to match the new assignment.

Instance Audit Log

The Instance Audit Log records all changes to the Line Item Modeling Solution Administrator 

security groups for each instance, including who made the change and when it occurred.

NOTE: If a planning instance is fully uninstalled, all associated audit log data is 

removed.

To view the Instance Audit Log, click the Audit Log button and a new page opens.
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Application Setup Options
The Setup Wizard provides a user-friendly, step-by-step process, ideal for first time setup or those 

who prefer a more guided experience. The Configuration option offers more control for users who 

are comfortable importing a configuration file that already contains all the solution settings in a 

single JSON file. Review the sections below and select the option best suited to your setup needs.

NOTE: Only administrators can set up the solution, adjust the settings and see the Line 

Item Modeling solution Installer.

Setup Wizard
Launch Setup Wizard: From your configuration Welcome Page, click the Start button to begin 

the Setup Wizard. If this is the first time you are installing the solution, or you do not have a 

configuration file generated from a previous version of the solution, the Setup Wizard is the 

recommended option.

NOTE: Select the Exit button at any time to  return the Welcome Page. 

Line Item Modeling Guide 12

Setup and Installation



This section will guide you through setup of the Register, Accounts, and Security steps. The Setup 

Wizard has built-in validations to make sure all necessary information is populated. In the Security 

setup, dialog boxes will display if you skip over a step and inform you to go back and fill in any 

missing criteria.

IMPORTANT: Any attribute named in the solution, such as Register Field Names, 

Accounts, Global Drivers, Cube Drivers, Lookup Drivers and Formula Names, must be 

unique from each other.

Register

Step 1 of the Setup Wizard is the Register. This is a crucial tool that aids in the initial configuration 

and ongoing management of your planning environment. It is designed to streamline the setup 

process and make it easier to define your Register and the attributes within it.

Through the Setup Wizard Register, you can dynamically load your column definition and 

configure a variety of settings, including display names, data type, control lists, and data 

dimensions.

The Register portion of the Setup Wizard ensures that you can set up your Line Item Modeling 

solution according to your specific business requirements.
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It is essential to review and update the settings in the Setup Wizard Register periodically to ensure 

they remain aligned with any changes in your business operations or planning needs.

Register Setup

Register Definition: In this step, you will dynamically create the columns used for your Register. 

These fields, for example, can come from your human resources (HR) source if you are in the 

Workforce Planning solution. Some examples include Employee ID, Job Title, Department, and 

Status. These columns within the Register Definition table will help define your Register:

 l Register Field Name: The column name that is imported from your .csv file.

 l Display Name: The column name that will display on your Register. Display Name can only 

contain letters a to z, numbers 0 to 9, underscore characters, and spaces.

 l Data Type: Define the data types for each Register column. You have these options: String 

(numbers or letters), Date, and Number. It is important to assign the correct Data Type for 

your Register Field Names based on the data you intend to import into the Register later in 

the planning process.

 l Column Format: Define the formatting for each data type using the drop-down menu. 

Formatting types include: decimal places (N#), dates and Percentages (P#). Choose from 

the following: blank (default), N0, N1, N2, N3, N4, N5, N6, N7, N8, N9, MM/dd/yyyy, 

dd/MM/yyyy, yyyy/MM/dd, P0, P1, P2, P3, P4, P5, P6, P7, P8 or P9.

NOTE: The assigned formatting for dates in the Register Definition will override 

date formatting from a culture code.

 l Date Assignment:
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 o For the Workforce Planning and Fixed Term Planning configurations, select a 

Register field to have a start and end date assigned for your incremental and periodic 

calculations.

 o For the Duration Based Planning configuration, select a Register field to have a start 

date and duration assigned for your incremental and periodic calculations. The 

duration selection can only be an integer ranging from 0 to 2400.

 l Allow Updates: You have the option to allow updates on certain columns. This will 

determine which columns can or cannot be modified in the Register.

IMPORTANT: If this attribute is not assigned, you will not be able to edit 

regardless of security permissions.

 l Required Column: Select which Register columns you want to be required when importing 

and editing Register data.

 l Member Definition: Define which member metadata you want to assign to a Register 

column.

NOTE: If your member definition is using extensibility where there is more than 

one dimension, and you want to plan at a more detailed level, you can define the 

specific dimension in your member definition. For example, 

U1#CC100.Base:Dim:Equipment Cost Centers Budget. Member definitions link 

core dimensionality to the Register and provide data validations and security 

options within the Line Item Modeling solution.

 l Parameter Name: Provides the option to select a predefined parameter in your application 

to assign to a Register column.

 l Control List: Indicates if the Register column has control list values.
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 l Default Value: Define a custom default value for each Register column. If you input a value 

that does not match the assigned data type or input a value that is not included in the 

member definition, a dialog box displays. When a new row is added to the Register, the 

default value populates for that field.

NOTE: If you have a default value assigned and import a new .csv file, the default 

value is automatically applied to the column upon saving the Register.

There is also a control list table next to the Register Definition table that enables you to populate 

acceptable control list values for each Register field. For example, if you have a Register field 

name of Region and you only have data for two regions, USA and Canada, you can input those 

values in the table to make sure no other regions are accepted. When you assign a member 

definition to a row in the Register table and save it, the control list automatically populates the 

associated member definition values for that row which provides the option to assign security to 

list members in step 3 of the Setup Wizard. See Security Setup.

Before importing, verify that the Register columns within your .csv file only contain letters a to z, 

numbers 0 to 9, or underscore characters to avoid any issues or missing data in your Register.

To set up your Register, follow the legend and corresponding instructions:
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 1. Click Select File and a dialog box displays prompting you to upload a file. The Register 

Definition will populate with the data and order of the .csv file. Example .csv file:

TIP: You can manually add or remove entries using the grid toolbar or use the 

arrow icons at the top right of the Register Definition table to reorder the Register 

Definition columns.

 2. Once the table is populated, you will see a list of all your columns in the Register Definition 

table. Set the member definition by clicking the Member Definition button . 

The Member Filter Builder dialog box is displayed for member definition creation. Create 

the member definition and then click the OK button.

 3. Copy the member definition in the text box created in step 2 and paste it into the Member 
Definition column for the Entity row. Entity is a required field, and it should only be applied 

to one Register Field Name.
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NOTE: You can also assign a User-Defined (UD) member definition for other 

Register field names based on your planning needs. This can be done through the 

Member Filter Builder as well. Only one token type can be assigned to a Register 

Field Name.

 4. Select the Data Type for each Register Field Name. Choose from the following: Number, 

String or Date.

 5. In the Date Assignment column, select a cell and use the drop-down menu to select a 

Start Date and End Date for your corresponding Register Field Name. Start Date and End 

Date are required fields.

NOTE: The Workforce Planning and Fixed Term Planning configurations use the 

Start date and End date selections. The Duration Based Planning configuration 

uses a Start date and a Duration selection.

 6. Select the checkbox in the Allow Updates column for each Register Field Name you want 

to allow editing access for. Leaving it blank means that the field is read-only and cannot be 

updated.

 7. Select the checkbox in the Required Column column for each Register Field Name to 

define if data is required when importing and editing the Register data during the planning 

process.

 8. Setting the Parameter Name for each Register Field Name is optional. Set them by 

selecting a row and using the drop-down menu in the Parameter Name column. You can 

also search for a parameter by using the drop-down menu and then typing in the text box.

 9. In the Default Value column, select a value for each Register Field Name.
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 10. In the Column Format column, select a value for each Register Field Name. Choose from 

the following: blank (default), N0, N1, N2, N3, N4, N5, N6, N7, N8, N9, MM/dd/yyyy, 

dd/MM/yyyy, yyyy/MM/dd, P0, P1, P2, P3, P4, P5, P6, P7, P8 or P9.

 11. (Optional) You can use the control list table next to the Register Definition table to populate 

acceptable values for each Register field as well as the stored value and display value.

TIP: You can use the arrow icons in the Control List table to reorder control list 

values.

NOTE: The control list column in the Register Definition table indicates if a 

Register column has control list values. This will update automatically upon 

clicking the Save or Next button on the Setup Wizard or by going to Settings > 

Register Definition and clicking the Update button.

 12. Click the Next button and a dialog box displays. Select Proceed or Cancel.

There are built-in validations, so you will not be able to move forward if there is missing or 

incorrect information entered in Register Definition table. For example, if you are missing a 

Display Name, you have two different dimensions tokens being used in the same column, or if you 

have the same dimension token on two different columns, a validation message will display.

Accounts

In OneStream's Line Item Modeling solution, the term Accounts often refers to the accounts that 

are set up and used in formula creation and where the calculated values are stored. These 

accounts are crucial for ensuring the calculated values in your plan table are placed in the 

appropriate account. You can use the same account name and description as your application 

metadata or add accounts that may not be in your account structure but will help in calculating 

values on a more detailed level.
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Before you import, verify you are using a .csv file. The column names on the .csv file must match 

the table shown in the solution.

Example:

IMPORTANT: Any attribute named in the solution, such as Register Field Names, 

Accounts, Global Drivers, Cube Drivers and Formula Names, must be unique from each 

other.

To import Accounts, follow the legend and corresponding instructions:
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 1. Click the Import button and a dialog box displays prompting you to upload a file. 

TIP: You can also manually add or remove entries using the grid toolbar.

 2. Click the Next button.

NOTE: There are built-in validations so you will not be able to move forward if 

there are issues, such as duplicate account names.
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Security Setup

OneStream's Line Item Modeling Installer allows you to have different configuration types and set 

up security for each using the Wizard Security Groups, ensuring secure access control and data 

protection. These groups define the level of access and permissions each user or user group has 

within the system, enabling administrators to effectively manage who can view, edit, or approve 

data. By structuring user access rights through the Security Groups, organizations can maintain 

control over sensitive information and prevent unauthorized alterations. This feature enhances 

the security of the planning process and fosters accountability and proper data management 

within the organization. It is an essential component for businesses looking to safeguard their 

data while promoting a collaborative planning environment. See Security to adjust Security 

groups.

NOTE: Line Item Modeling enforces nested security, evaluating parent-level security 

first to allow access before child-level security is applied.

NOTE: The Manage Transfers action is only available in the Workforce Planning 

configuration.

To set security groups for Actions, follow the legend and corresponding instructions:
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 1. Click the Actions button.

 2. Select a row.

 3. Select security groups.

TIP: You can search for a security group by typing in a security group name and 

clicking the Search button.
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 4. Click the Save button. You can revert your security group selections by clicking the Undo 

button.

IMPORTANT: You need to click the Save button after each Action security group 

selection.

To set the security groups for Register Columns, follow the legend and corresponding instructions 

below:
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 1. Click the Register Columns tab.

 2. Select a row.

 3. Click the Column Visibility tab.

 4. Select security groups.

TIP: You can search for a security group by typing in a security group name and 

clicking the search button.

 5. Click the Save button. You can revert your security group selections by clicking the Undo 

button.

IMPORTANT: You need to click the Save button after each Action security group 

selection.

To set the security groups for control list values, follow the legend and corresponding instructions:
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 1. Click the Register Columns tab.

 2. Select a row with control list values.

 3. Click the Control List tab.

 4. Select a row.

 5. Click the Read Only tab to set read-only permissions or click the Read/Write tab to set 

read/write permissions.

 6. Select security groups.

TIP: You can search for a security group by typing in a security group name and 

clicking the search button.

 7. Click the Save button.
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IMPORTANT: You need to click the Save button after each Action security group 

selection.

 8. Click the Finish button.

The Control List Source column in the Register Columns tab indicates if control list values are 

populated from a Member Definition or custom control list. Security settings for members on the 

Entity dimension cannot be modified in Line Item Modeling. These settings are inherited from the 

dimension library and reflect the security applied there.

NOTE: Security can only be applied to member definitions or custom control lists but not 

to parameters.

The following table details the actions you can set security groups for.

NOTE: OneStream Administrators will not automatically have rights to the inner 

workings of this solution. If you have Administrators responsible for any of the Actions 

listed below, you must assign the Administrators group to the action or include those 

individuals to the security groups assigned. This also applies to row level security on the 

Entity, UD's or Control List items.

Actions User Function

Add Register 

Data (Bulk)

User can import Register bulk data.

Edit Register 

Data

User can edit Register data. Edits include updating a row that exists and 

adding a row.
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Actions User Function

Delete 

Register 

Data (Bulk)

User can delete Register bulk data.

Delete 

Register 

Data

User can delete Register data. This permission allows specific users to 

delete an existing row. If a user has permission to Delete Register Data, they 

also have Edit Register Data permission.

Manage 

Transfers

User can execute transfers and is not data dependent, meaning this role is 

not tied to column or member security. The user assigned to this action can 

apply the execution of transfers globally within any intersection of data. This 

action is only available in the Workforce Planning configuration.

View Audit 

Log

User can view the Audit Log.

Manage 

Filters

User can create, edit, copy or delete Register filters.

Calculate 

Plan

User can calculate plan data.

View Plan User can view plan data.

Lock Plan User can lock plans.

Unlock Plan User can unlock plans.
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Actions User Function

Manage 

Plans

User can create, edit, copy, calculate or delete plans.

View Drivers User can view Global Drivers, Lookup Drivers and Cube Drivers.

Manage 

Drivers

User can import Global Drivers, Lookup Drivers and Cube Drivers.

View 

Formulas

User can view formulas.

Manage 

Formulas

User can create, edit, copy or delete formulas.

Configuration
The configuration option enables you to import a file that already contains solution settings from a 

different instance or another application and apply them automatically. The naming of the 

configurations is based on the specific planning use case:

 l LIMA1 - First instance and schema Fixed Term Planning

 l LIMB1 - First instance and schema of Workforce Planning

 l LIMC1 - First instance and schema of Duration Based Planning
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IMPORTANT: You cannot import a configuration file into a planning instance that was 

created from a different planning configuration. For example, you cannot import a 

Workforce Planning configuration file into a Fixed Term Planning instance of the 

solution.

 1. From the main Setup Wizard dashboard, select the Import File button to begin the setup 

process. You can only access the import of a configuration file during the Setup Wizard 

process.

 2. Select the file you want to import and then select the Open button.

NOTE: When you import a configuration, Cube Driver and Lookup Driver values won't 

display in the preview table until you add Register data. Your Cube Driver or Lookup 

Driver is trying to compare values that are in the Register against values that are in a 

Cube or Lookup table so data needs to exist in the Register for that comparison to 

happen.

Map Invalid Members

When importing  a configuration file, the system detects Plan and Cube Driver member IDs or 

member names that do not exist in the target application. To help administrators resolve these 

issues before the configuration loads,  a mapping dialog  identifies invalid Plan members and 

allows them to be mapped to valid members within the application. A Cube Drivers tab also 

displays any invalid  members, but is only informational and will require updates after the 

configuration loads. See Cube Driver Invalid Members for information on resolving invalid 

members.

To map invalid Plan members, follow the legend and corresponding instructions:
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 1. Select a row.

 2. Select the Select Valid Member cell.

 3. Select a valid member.

 4. Select the Save icon.

After closing the mapping dialog, the configuration continues to load and the Plan members 

map correctly.
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Settings
In OneStream's Line Item Modeling solution, the Settings drop-down menu enables the Line Item 

Modeling solution administrator to access the settings for Register Definition, Accounts, and 

Security. If further adjustments need to be made to the settings, you can do so from the respective 

dashboards. In addition to accessing your current solution configuration, this solution offers a way 

to export your configuration and apply it to another application or instance. See Configuration. As 

an administrator, you can export your configuration JSON file to capture additional settings, such 

as Global Drivers, Cube Drivers, Lookup Drivers or Formulas, which are detailed in the 

documentation. The standard Uninstall Full option is available in Settings as well. See Uninstall.

To access the settings menu, follow the legend and corresponding instructions:

 1. Hover your cursor over the Settings menu.

 2. Choose from the following settings menus: Register Definition, Account, Security, 

Configuration, and Uninstall.
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Register Definition
The Register Definition menu enables you to add new member definitions and make row and 

column updates to your Register Definition. After your changes are made you can click the Save 

button on the Register Definition table and your changes will only be reflected in the Register 

Definition table. To save your changes and apply them throughout the solution, click the Update 

button. If you update a data type, you are notified that the Register data will be removed because 

a new structure for the Register Definition has been established and you can either proceed or 

cancel.

NOTE: To change the start and end date assignments, Register data must be removed.

There are built-in validations preventing you from moving forward if there is missing or incorrect 

information entered in the Register Definition table or control list table. Some examples are:

 l You are missing a display name

 l You have two different dimensions being used in the same column

 l You have control list values that don't match the data type of the Register column
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Register Definition Table

In the Register Definition table, you can insert a new  row, remove row, cancel all changes prior to 

saving and save any updates without having to do a bulk .csv file import of Register fields. Once 

your changes have been saved and you click the Update button, your Register reflects the 

updates made in the Register Definition.

NOTE: If you change and save the column order in the Register’s Dynamic Grid, the 

saved user state overrides any column order defined by a Solution Administrator on the 

Register Definition.

Use the following icons to reorder your Register Definition columns:

 l Move to top

 l Move up one

 l
Move down one

 l Move to bottom

Click the Update button to apply your changes.

The column order defined in the Register Definition table is applied throughout the solution. When 

a new row is added or the .csv file is reloaded, any new fields or fields in use will automatically be 

shifted to the bottom of the Register Definition and, by default, display on the far right side of the 

Register. The grid component will allow you to modify your column order in its saved state.
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 l To Insert a Register row, click the  button. Enter the Register field and display name 

and update any other column attributes.

 l To remove a Register row, click the  button.

 l To cancel all changes prior to saving, click the  button.

 l To save, click the  button.

NOTE: There may be instances that will prevent an update to your Register Definition in 

which you will receive a message that describes why it's prevented. For example, if you 

are trying to delete a Register Field that is in-use, you will receive a message stating 

where it's being used (a Register Filter Group, Driver, or Formula).

Control List Table

In the Control List table, you can perform the following actions:
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 1. Import a .csv file. Example:

NOTE: File must have the Stored Value and Display Value columns in that order. 

Importing a .csv file enables you to load many control list values at once.

 2. Insert Row

 3. Delete Row(s)

 4. Cancel all changes prior to saving

 5. Save

Use the following icons to reorder your control list values:

 l Move to top

 l Move up one

 l
Move down one

 l Move to bottom
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 Click the Update button to apply your changes. You can also use the Sort icon  to sort  by 

ascending or descending order.

The control list table enables you to input a stored value and display value to manage control list 

values with greater detail and description. The data type selected in the Register Definition must 

match the data type of the control list values. You cannot enter a date value in a control list.

NOTE: You cannot remove control list values that are used in a Register filter group or 

formula.

If you make an update in the Control List table and click the Save button, the updated control list 

values will only be reflected in the Register Definition.

IMPORTANT: Once the changes have been saved, if you want the update to be 

reflected throughout the solution, click the Update button.

Account
The Account menu enables you to view, import, add, update, and remove accounts. After any 

updates are made, click the Save button.

Click the Import button to load any bulk changes to your .csv file.

Example:
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NOTE: If an account is currently being used in a formula, the account automatically 

remains in the table. All other accounts are removed, and the table then includes the 

new .csv file as well as the accounts used in formulas.

In the Accounts table, you can perform the following actions:
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 1. Insert Row

 2. Delete Row(s)

 3. Cancel all changes prior to saving

 4. Save

NOTE: You cannot remove an account that is used in a formula; however, you can edit 

the Account Description of an account that is currently being used in a formula.

Security
Security in OneStream's Line Item Modeling solution is a fundamental component designed to 

protect sensitive data and ensure access control. The Security Groups feature enables 

administrators to define access levels and permissions for each user or user group, providing 

granular control over who can perform specific actions, access certain pages, or view and edit 

data. Furthermore, OneStream's Line Item Modeling solution complies with industry-standard 

security protocols, ensuring your data is safeguarded according to best practices. This robust 

security framework enables organizations to leverage the power of the Line Item Modeling tool 

confidently, knowing their data is well-protected.

NOTE: Line Item Modeling enforces nested security, evaluating parent-level security 

first to allow access before child-level security is applied.

You can add, save, edit, or remove Security Groups. Multiple security groups can be assigned to 

Actions or Register Columns for more control of what users can have access to. The Register 

Columns shown are based on the .csv file load from the Register setup.

For additional information on updating security groups for Actions, Register Columns and Control 

List values, see Security Setup.
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NOTE: The Manage Transfers action is only available on the Workforce Planning 

configuration.
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Configuration
Configuration enables you to package and reuse the current settings of your solution, such as: 

Register Definition, accounts, security, Register group filters, Global Drivers, Cube Drivers, 

Lookup Drivers, Formulas and Plan criteria. Using a Configuration can be helpful when switching 

from a development environment to a production environment, allowing for faster implementation 

and less manual setup.

The naming of the configurations is based on the specific planning use case:

 l LIMA1 - First instance and schema Fixed Term Planning

 l LIMB1 - First instance and schema of Workforce Planning

 l LIMC1 - First instance and schema of Duration Based Planning

IMPORTANT: The Audit Log, Register and Plan data cannot be exported with a 

configuration file.

NOTE: When you import a configuration, Cube Driver and Lookup Driver values won't 

display in the preview table until you add Register data. Your Cube Driver or Lookup 

Driver is trying to compare values that are in the Register against values that are in a 

Cube or Lookup table so data needs to exist in the Register for that comparison to 

happen.

To export a configuration, follow these instructions:
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 1. Click the Export button.

 2. In the File Explorer, select the folder location to store the configuration file, and click the 

Select Folder button.

NOTE: A placeholder file name is given to the configuration file in the following format: 

Solution/Type Code/Instance_Configuration_Version Number_Timestamp. For 

example, LIMB6_Configuration_v1_20250929-1115.json.

Uninstall
To uninstall a planning configuration, follow the instructions:

 1. Hover your cursor over the Settings menu.

 2. In the drop-down menu, select Uninstall.

 3. Click the Uninstall Full or Uninstall UI button.
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 l Use the Uninstall Full button to remove all related data tables, data, workspaces 

and workspace components, but retain business rules.

 l Use the Uninstall UI button to remove all dashboards, but retain databases, related 

tables and business rules.

IMPORTANT: A dialog box will display to confirm if you want to proceed.

IMPORTANT: The Uninstall UI option retains business rules and extenders  in the 

application. The Uninstall Full option removes all solution components including 

business rules and extenders. Business rules or extenders created outside of Line 

Item Modeling that are referenced by Line Item Modeling are not removed during 

either uninstall option.

Line Item Modeling Guide 43

Settings



Register
The Register in planning and management is usually a record keeping tool that tracks various 

details and data points. In the context of Workforce Planning, it refers to a tool for managing 

details about personnel, such as their roles, skills, and schedules. It might be used in human 

resources or project management to ensure that the right personnel are allocated to the right 

tasks. You can import and modify data and then calculate and analyze that data to make 

decisions about various types of planning.

Import and Modify
There are two options for importing data into the solution: using a .csv file or a connector.

 1. Prepare your data: Before importing, ensure your data is in the correct format.

CSV import:

Organize your data in a .csv file, with each column representing a different data point (for 

example, name, role, schedule), and each row representing a different individual.

The following delimiters can be used in a .csv file import:
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 l ,

 l ;

 l \t

 l |

 l :

Connector:

The connector option uses a business rule to connect to an external source like an HR 

system.

An application business rule template is preconfigured for loading from a connector but 

requires you to replace information with your own implementation to populate the Register 

structure. Each instance of a configuration has its own business rule. To access this 

business rule template, go to Application > Business Rules > DashboardExtender and 

then locate your planning configuration import Register connector instance 

[ConfigurationName]ImportRegisterConnector[InstanceNumber]. See the example below 

for the first instance of the Workforce Planning configuration 

(WorkforcePlanningImportRegisterConnector1):
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 2. Import your data: Navigate to the import function in your planning Register and load from a 

local file or an external source. You can import a file and replace all the current data or only 

add new rows of data by selecting the append new rows option.

 3. Map your data: The solution compares the fields used in your import to the fields that are 

defined in your Register Definition. If they match, the data loads into the Add data stage 

table. If they do not match, the system will consider that column name as invalid. The stage 

table in the Add Data breadcrumb is utilized to validate the data being imported. The 

validation checks that the date type matches, invalid members are not imported and 

duplicate line items do not exist.

 4. Complete the import: Once everything is correctly mapped and all data validations are 

successful, save the Register. The system will populate the Register with your data and the 

stage table will be cleared.

Add Data to Register

To add data to the Register, follow the legend and corresponding instructions:
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 1. Hover your cursor over the Register menu.

 2. In the drop-down menu, select Import & Modify.

 3. Click the Add Data button.

 4. Click the Import button.

 5. In the Import pane, select an import type:
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 a. Select the Load file checkbox to load data from a local file.

 b. Select the Load from connector checkbox to load data from an external source.

 6. In the Import pane, select an import method:

 a. Select the Replace all checkbox to replace all data in the Register.

 b. Select the Append new rows checkbox to only add new rows of data to the 

Register.

 7. Click the Import button and upload a file.

Example:

 8. Click the Save To Register button.

Validations upon import ensure your data is correctly formatted and matches what was set up for 

the solution, such as:

 l Register column definition: You have a column in your import file that is not defined in the 

solution.

 l Duplicate column: You have duplicate column headings or values.

 l Data type: You have an incorrect data type in one of your columns.

 l Control list: You have values in a column that do not match the control list values for that 

column.

 l Connector: You do not have a connector implemented correctly.
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 l Required column: You do not have data in your required column.

 l Invalid Value: You have incorrect cultural date or number format values.

Validations upon editing ensure your information does not get removed or go against any 

preselected attributes of the solution.

 l If you input the wrong value type in a cell, for example, you enter letters in a column that 

should only have numbers, a dialog box opens informing you of an error.

 l If you try to add or replace any data for a column that has a member definition that you do 

not have write access to, a dialog box displays and your change is unsaved. Resolve any 

issues before saving again because the solution will not complete a save until all edits are 

valid.
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 l If you try to load and then save a new .csv file that has members that you are not permitted 

to edit, a dialog box will display. Only the entities that you have write access to will be 

updated and will replace the previous data.

 l If you are missing values in a required column, a dialog box displays.

If you import a .csv file with numbers used at the beginning of a column name or spaces used in a 

column name, the application automatically adds the prefix of Col_ to ensure the import is usable 

and compatible with the solution.

NOTE: If you import a .csv file that has different member definitions than what you 

defined in the Setup Wizard or Configuration import, a dialog box displays informing 

you of an invalid member.
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Modify Data in the Register
 1. Locate the data: Navigate to the data you want to modify. This involves searching for a 

specific individual or record, or filtering the Register to display certain data.

 2. Edit the data: Once you've located the data, select the field you want to edit. This enables 

you to directly input new data or select from a drop-down menu. You must have security 

access to edit data.

 3. Save your changes: After editing the data, ensure you save your changes. This is done by 

clicking Save button.

Editing the Register

You can edit the Register by using the Register grid controls, Spreadsheet tool or the Excel Add-

In.

Register

The Register uses the Dynamic Grid enabling you to add, remove, cancel all changes prior to 

saving, and save Register values. You can also select a cell in the Register and a list of drop-

down values will display based on member definitions, control lists, or parameter values assigned 

from the Register Definition.
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 1. Insert Row

NOTE: When you insert a row, default values will automatically populate.

 2. Delete Row(s)

 3. Cancel all changes prior to saving

 4. Save

All of these functions are tied to security access, so if you do not have security access to delete 

rows, you will not be able to perform that action. You can view the Editable column to verify which 

rows of information you have read/write access to. A checked box indicates read/write access. If 

you make edits to information you do not have access to, a dialog box displays and the 

information will remain.

Spreadsheet Tool

The Spreadsheet tool opens a new page which enables you to make edits to your Register and 

not have to upload a new set of data every time you need to make an update. The tool enables 

you to edit a single cell, edit multiple cells at once, copy and paste from cell to cell, copy and paste 

a row to a new row, right-click and insert a row, and delete rows.

The spreadsheet tool also utilizes drop-down menus within cells in a column. These drop-down 

menus populate from control lists and parameters that have been assigned in the Register 

Definition for a quick way to make updates and avoid invalid entries.

To edit your Register using the Spreadsheet tool, follow the legend and corresponding 

instructions:
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 1. Hover your cursor over the Register menu.

 2. In the drop-down menu, select Import & Modify.

 3. Click the Spreadsheet button.

 4. Complete edits and click the Save button.

 5. Click the X button to navigate back to the Register read-only page.

NOTE: When scrolling through your data, the header row remains fixed at top of the 

spreadsheet so you do not lose track of which column the information is in.

Certain validations are put in place to make sure your information does not get removed or go 

against any preselected attributes of the solution, such as:
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 l Columns cannot be removed if selected column data is being used in a formula. To remove 

the column data, formula information must be updated to reflect the change you want to 

make.

 l When editing the Register, you cannot update the column name or add a new column. If 

you right-click on a column, the Insert and Delete selections are unavailable. If changes are 

made to the column name and other row information, a dialog box displays and only the row 

information changes are saved.

Excel Add-In

You  can  edit Register data directly through the Excel Add-In which provides a streamlined, 

spreadsheet-based editing experience without  navigating into the Line Item Modeling solution. 

See "Excel-Add-In" in the Design and Reference Guide. 

To access Register data in Excel:
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 1. On the Onestream tab in Excel, click the Log In button.

 2. Sign in to the OneStream application, then click the Table Views button.

 3. In the Table View Definitions dialog box, click the Add button.

 4. In the Name field, enter RegisterEditor.

 5. In the Table View Business Rule field, click the ellipses icon to select the  workspace 

business rule for a Line Item Modeling instance.

 6. Click the OK button.

The table view automatically filters the displayed records so you only see items  you have 

read/write access for. Updates flow through to the Line Item Modeling Register, and each 

modification is recorded in the audit log. Given you have permission for the actions in the instance 

Security Model, you can delete, add or edit row data.

View Data

To view your Register data or plan data, use the pagination tools. Users are only able to view the 

Register information they have security access to.

 1. Skip to the first

 2. Navigate to the previous page

 3. Select a page

 4. Navigate to the next page

 5. Skip to the last page
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 6. Number of rows

 7. Total number of rows

Select a column header to sort a column in ascending or descending order.

Delete Rows

To delete rows in the Register, you must have security access.

To delete a row, follow the legend and corresponding instructions:
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 1. Select a row.

 2. Click the Delete Row(s) button.

 3. Click the Save button.

Delete All Rows

To delete all rows in the Register using the Delete All action, you must have the Delete All 

Register Rows (Bulk) action permission.

IMPORTANT: The Delete All action deletes all rows, not just the rows you have write 

access to.

To delete all rows, click the Delete All button. A validation message displays to confirm the 

deletion.

NOTE: Plan data and Register filter groups will remain.

Audit Log

The Audit Log provides a detailed history of data changes in the Register and allows you to track 

who made them. It is read-only and can be viewed if you have security access. Only saved 

changes display in the Audit Log.
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To view the Audit Log, follow the legend and corresponding instructions:

 1. Hover your cursor over the Register menu.

 2. In the drop-down menu, select Import & Modify.

 3. Click the Audit Log button and a new page opens.

The Audit Log displays the following columns:
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 l Type: Displays the type of change made such as Delete, Delete All, Update, Insert, 

Transfer or Import.

NOTE: The Audit Log history will remain when the Delete All action is used.

 l Source: Displays the source of the change such as Grid, Spreadsheet, Append-File, 

Replace all-File, Replace all-connector or Append-connector.

 l Original Data: Displays all column values of the original data.

 o If data is inserted, the Original Data cell is blank since there is no previous 

information.

 o If data is imported by a file or a connector, the Original Data cell displays NA.

 o If the Delete All action is used, the Original Data cell is blank since all data was 

removed.

 o If the Transfer feature is used, the Original Data cell is blank since a new row is 

added to the Register once a transfer is complete.

 l Changed Data: Displays the specific changed data.

 o If the specific data is removed or the Delete All action is used, the Changed Data cell 

is blank since the data was removed.

 o If data is imported by a file or a connector, the Changed Data cell displays NA.

 o If data is inserted, the Changed Data cell displays all column values of the new data.

 l User: Displays who made the change.

 l Date/Time: Displays when the change was made.
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Transfer

The Transfer feature enables you to manage employee transfers between different parts of your 

business such as departments, entities or cost centers and execute the transfer in the Register. 

When you click the transfer button, a separate transfer pane opens for editing the employee 

Register information. Only users with the Manage Transfers action security permission can utilize 

the Transfer feature and view the transfer changes in the Register.

IMPORTANT: The Transfer feature is only available in the Workforce Planning 

configuration.

Execute Transfer

To execute a transfer, follow the legend and corresponding instructions:

Line Item Modeling Guide 60

Register



 1. Click the Transfer button. The Transfer pane opens.

 2. In the Register, select a row.

 3. In the Transfer pane, update Register fields.

NOTE: You have access to Register fields that have the Allow Updates or 

Required column enabled in the Register Definition.

 4. Click the Execute Transfer button. A new row is added to the bottom of the Register.

NOTE: The start date of the Transfer becomes the end date of the initial row.
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Manage Filters
After a Register is saved, you can use the Manage Filters button to set specifications to populate 

distinct sets of information. You can select a variety of factors in the filter tool to create new 

conditions or groups.

To create a new filter, follow the legend and corresponding instructions:
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 1. Click the Manage Filters button and a new pane will open.

 2. Click the And button and a drop-down menu will open to display options: And, Or.

 3. Click the plus button to display options: Add Condition or Add Group.

NOTE: For the Windows application, select the drop-down arrow next to the plus 

icon to display the options.
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 4. Click the first box to display a drop-down menu of your columns. Make a selection.

 5. Click the second box to display a drop-down menu of operations. Make a selection.

 6. Click the third box, and type in the value you want to filter for.

 7. Click the Apply button.

After the filter has finished running, your Register view displays the filtered data as well as an 

updated row and page count.

Save a Filter

To reuse a filter, save it as a group and avoid recreating filters.

To save a filter as a group, follow the legend and corresponding instructions:
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 1. With a filter created and applied, locate the text box at the bottom of the Filter Group 

Manager pane and add a name.

 2. Click the Add/Copy Filter Group button.

 3. The filter displays in the Select group drop-down menu.

Copy a Filter

To copy a filter, follow the legend and corresponding instructions:
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 1. Click the Manage Filters button.

 2. Select a filter group from the drop-down.

 3. Add a new Filter Group Name.

NOTE: Filter Group Name must be unique.

 4. Click the Add/Copy Filter Group button.

Update a Filter

To update a filter, follow the legend and corresponding instructions:
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 1. Click the Manage Filters button.

 2. Select a filter group from the drop-down.

 3. Update the filter criteria.

 4. Click the Apply button.

 5. Click the Update Filter Group button.
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Delete a Filter

To delete a filter, follow the legend and corresponding instructions:
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 1. Click the Manage Filters button.

 2. Select a filter group from the drop-down.

 3. Click the Delete Filter Group button.

NOTE: You cannot delete a filter group being used in a formula.

Calculate and Analyze
 1. Use Built-in Calculation Functions: Most planning registers or management software 

have built-in calculation functions. The Line Item Modeling solution offers DateDIFF

(Month), DateDIFF(Year), DateDIFF(Day), IIF, CurrentPeriod, AND, OR, ISNULL, 

RollingPeriod,  Like, and CurrentYear functions.

 2. Create Custom Formulas: If the built-in functions are insufficient, you can create custom 

formulas. See Formulas. This enables you to combine data in unique ways to identify 

insights, specific to your needs.

 3. Apply Calculations to Data Groups: You can apply these calculations to specific groups 

of data created by the filter builder. For example, you might calculate the average skill level 

of employees in a certain department or the total hours worked by employees on a specific 

project.

Analyze Data in the Planning Register

To narrow your analysis, you can filter and sort your data by using the Manage Filters button. See 

Manage Filters. For example, you might filter to only show data from a certain time period or sort 

data by highest to lowest values. You can also add more Register columns to a plan for reference. 

See Plan Data.
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Formulas
Formulas in OneStream's Line Item Modeling solution are used to leverage Global Drivers, 

Lookup Drivers, and Cube Drivers to create meaningful and accurate calculations and develop 

driver-based operational plans. They can be applied to a wide range of data fields, from basic 

arithmetic operations to complex business calculations.

Workforce Planning Use Case

This Use Case demonstrates the following situation:

 l Scenario: Build a set of formulas to determine if the federal tax amount still applies for 

an employee in a specific month.

 l Role: Implementer, Administrator

 l Benefits: Formulas can be individually created and the accounts applied to the formulas 

can be used as dependencies or building blocks for more advanced formulas to 

calculate more complex data.

See Workforce Planning FUTA Formula Use Case for more information.
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Global Drivers
Global Drivers in OneStream's Line Item Modeling solution are key variables or factors that can 

be used in formulas. These drivers can be financial indicators that are common concepts across 

organizations, for example, merit, bonus, tax limits and percentages, benefit amounts, and 

vacation days. Global Drivers can be used when you have a static value that can be used across 

all time or dimensions (one driver with one value).

By using Global Drivers, organizations can align their planning processes, improve accuracy, and 

enhance the comparability of results across different units or departments. It is a powerful tool for 

strategic planning, budgeting, and forecasting, helping decision-makers understand the impact of 

various factors on the company's performance.

IMPORTANT: Any attribute named in the solution, such as Register Field Names, 

Accounts, Global Drivers, Cube Drivers, Lookup Drivers and Formula Names, must be 

unique from each other.

Import Global Drivers

To import a bulk file of Global Drivers, follow the legend and corresponding instructions:
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 1. Hover your cursor over the Formulas menu.

 2. In the drop-down menu, select Global Drivers.

 3. Select the Import button. In the dialog box, select a file and select the Open button.

Example:

NOTE: You cannot save if there is a duplicated Name or Display Name.

To update or add to the current Global Drivers, you can import an updated .csv file or use the 

Global Drivers grid controls. In the Global Drivers grid, you can add, remove, cancel all changes 

since last save, and save Global Drivers.
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 l To Insert, click the  button.

 l To remove, click the  button.

 l To cancel all changes prior to saving, click the  button.

 l To save, click the  button.

NOTE: Global Drivers that are referenced in a saved formula cannot be removed.

When you import a new .csv file, that file is compared with the current list of Global Drivers. 

Drivers that are not used in a saved formula are removed if they are not included in the imported 

file. Drivers that are used in saved formula are retained, even if they are not included in the 

imported file.

NOTE: If you import a .csv file with numbers used at the beginning of a column name or 

spaces used in a column name, the application will automatically add the prefix Col_ to 

ensure the import is usable and compatible with the solution.

Cube Drivers
Cube Drivers take the dimensionality of cubes used across OneStream and enables you to utilize 

their information for formula building and plan data creation within the Line Item Modeling solution. 

You can connect driver values from a Cube View to the solution by adding a Cube Driver. The 

Cube Driver is dynamic and changes based on any Cube View changes. When creating a Cube 

Driver, you can select the Variable option for Time Frequency to track values across multiple 

months and years to view all potential results from different time periods or you can select Fixed 

which will take the value of the specific month and year the driver is stored in.
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NOTE: A Cube Driver can be utilized across multiple years in the plan calculation, 

however, the Preview table of the Cube Driver only displays values for a single year.

On the Cube Drivers page, Cube Driver Names, Display Names and Statuses are stored in the 

table on the left and the associated cube driver values are presented in the table on the right. 

When you select a Cube Driver from the table on the left, the cube driver values will display in the 

table on the right. A Cube Driver may be tied to multiple entities, each with unique values.

NOTE: When you import a configuration, Cube Driver values won't display in the 

preview table until you add Register data and preview the new data. Your Cube Driver is 

trying to compare values that are in the Register against values that are in a Cube so 

data needs to exist in the Register for that comparison to happen.

IMPORTANT: Any attribute named in the solution, such as Register Field Names, 

Accounts, Global Drivers, Cube Drivers and Formula Names, must be unique from each 

other.
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When adding or editing a Cube Driver, you can use the Global checkbox to control whether a cube 

driver applies universally or only to specific dimensions. When selected, the driver is applied to all 

Register records, and the corresponding dimension column is removed from the preview. If left 

unchecked, the driver applies only to the selected dimension, and those columns remain visible in 

the preview. This setting ensures flexibility in managing calculations and configurations. Global 

checkboxes display for any dimension that has a Member Definition assigned to it in the Register 

Definition.

NOTE: Global selections are preserved when exporting configuration files.

When adding or editing a Cube Driver, you can  use Register fields as substitution variables by 

using the Substitution Variable Reference drop-down menu. It only lists the Register fields you 

have security access to and displays in pipe format such as |Grade|. When you select a Register 

field, its value appears in the  text box, allowing you to quickly copy and paste it into your Cube 

Driver definition  without navigating back to the Register.
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Cube Driver Invalid Members

If a configuration file is loaded with invalid Cube Driver members, the Status column on the Cube 

Drivers page indicates that edits are required for the Cube Driver to function properly.

To resolve, edit the Cube Driver and correct the  *Invalid Member* values. See Edit Cube Drivers.

Add Cube Drivers

There are two methods for adding Cube Drivers: copying and pasting the member script 

information from a cube view POV within the OneStream application or manually selecting all 

criteria.

You also can apply the column name of a Register field in the Account or UD dimension for a cube 

driver by typing the column name in between pipes. The pipe substitution variable using a 

Register column name dynamically injects the values from that column and will match values 

stored in the cube to generate a preview for those intersections. This allows you to leverage 

alternate Register fields that don't have a member definition assigned.
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Example: Input the Register column name Grade Level in the 

Account dimension as |GradeLevel|. Do not include spaces.

To add a Cube Driver by using the Member Script Helper, follow the legend and corresponding 

instructions:

NOTE: When you use a Top level cube in a member script, the solution finds the base 

cube level of which the Entity and the dimension resides in and will preview the data 

from that base cube.
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 1. On the Cube Drivers page, click the Add button.

 2. Paste the member script from your cube view in the Member Script Helper field.

NOTE: If a dimension is blank, all the values for that dimension will dynamically be 

pulled based on member definition. If you do not populate Entity, all Entity values 

from the Register are compared to the cube Entities and data will preview based 

on those intersections available. You can also leave a UD blank and if there is 

data stored at the UD level, it will retrieve the same way as entities. Leaving a field 

blank relies on there being a member definition to use the data from the Register 

to dynamically return values based on the intersection of where the data is stored 

in the cube.

 3. Click the Apply button.

TIP: If you need to update your dimensions, you can click on the Reset button to 

clear all your selections and the preview.

NOTE: If there are multiple cubes referenced in a UD or Flow Register column in 

the Register Definition, only the dimension correlating with the cube selection is 

utilized.

 4. Enter a Name.

 5. Enter a Display Name.

 6. Select a Time Frequency. Select Fixed for a single value based on the time selection. 

Select Variable for the values across the time selection.

 7. Select a Global checkbox to control whether a cube driver applies universally or only to that 

specific dimension.

 8. Click the Preview button.
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NOTE: If there is an invalid data intersection, a message box displays and you will 

need to update your selections on the Add Cube Driver page.

 9. Click the Save button.

IMPORTANT: The Save button displays once the preview table is populated 

successfully with no invalid intersections.

To add a Cube Driver without using the Member Script Helper, follow the legend and 

corresponding instructions:
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 1. On the Cube Drivers page, click the Add button.

 2. Enter a Name.

 3. Enter a Display Name.

 4. From the Cube drop-down menu, select a Cube.

 5. Select a Time Frequency. Select Fixed for a single value based on the time selection. 

Select Variable for the values across the time selection.

 6. Select a Time.

 7. Select a Scenario.

 8. Select the member filters for your dimensions by clicking on each dimension or entering 

values in the field. Select a Global checkbox to control whether a cube driver applies 

universally or only to that specific dimension.

If no selection is made, all the values for that dimension will dynamically be pulled based on 

member definition. If you do not populate Entity, all Entity values from the Register are 

compared to the cube Entities and data will preview based on those intersections available. 

You can also leave a UD blank and if there is data stored at the UD level, it will retrieve the 

same way as entities. Leaving a field blank relies on there being a member definition to use 

the data from the Register to dynamically return values based on the intersection of where 

the data is stored in the cube.

TIP: If you need to update your dimensions, you can click on the Reset button to 

clear all your selections and the preview.

NOTE: If there are multiple cubes referenced in a UD or Flow Register column in 

the register definition, only the dimension correlating with the cube selection is 

utilized.
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 9. Click the Preview button and the table will populate the corresponding member definitions 

and values.

NOTE: If there is an invalid intersection of data, a message box displays and you 

will need to update your selections on the Add Cube Driver page.

 10. Click the Save button.

IMPORTANT: The Save button displays once the preview table is populated 

successfully with no invalid intersections.

The values will display in the Cube Drivers table.

NOTE: You cannot save if there is a duplicated Name or Display Name.

NOTE: Ensure the entities used in the Register have the Member Property setting of 

InUse set to True in order for the Cube Driver dashboard to preview results. This can be 

configured in the Entity Dimensions area of the Application tab.

Edit Cube Drivers

To edit a Cube Driver, follow the legend and corresponding instructions:
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 1. On the Cube Drivers page, select a Cube Driver from the table.

 2. Click the Edit button.

 3. Update all relevant criteria.

 4. Click the Preview button.

 5. Click the Save button.

Delete Cube Drivers

To delete a Cube Driver, follow the legend and corresponding instructions:
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 1. On the Cube Drivers page, select a Cube Driver from the table.

 2. Click the Delete button.

NOTE: You cannot delete a cube driver that is being used in a formula.

Lookup Drivers
Lookup Drivers enable you to utilize values stored in XFC tables (any table with the prefix XFC_) 

within OneStream for formula and plan creation. Users often store ad hoc data in XFC tables to 

avoid unnecessary data inclusion in a cube or the Register. Lookup Drivers provide the ability to 

match column names in the Register with the column names in the Lookup table applied. The data 

points that match between the Register data and Lookup table within those columns provide a 

preview based on the return values drop-down selection that is available via the Lookup table.

If more than one Register field is populated in the Lookup Driver column, the values in the preview 

will concatenate the values of the Register Fields and display the Return Value based on those 

combinations.

NOTE: When you import a configuration, Lookup Driver values won't display in the 

preview table until you add Register data and preview the new data. Your Lookup Driver 

is trying to compare values that are in the Register against values that are in a Lookup 

table so data needs to exist in the Register for that comparison to happen.

IMPORTANT: Any attribute named in the solution, such as Register Field Names, 

Accounts, Global Drivers, Cube Drivers, Lookup Drivers and Formula Names, must be 

unique from each other.
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Add Lookup Drivers

To add a Lookup Driver, follow the legend and corresponding instructions:
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 1. On the Lookup Driver page, click the Add button.

 2. In the Select Table drop-down menu, select an XFC table.

NOTE: Only tables with the prefix XFC_ can be selected.

 3. Click the Apply button.

 4. Enter a name.

 5. Enter a display name.

 6. In the Return Value drop-down menu, select the column with the driver value you want to 

return.

 7. In the Lookup Column drop-down menus for each Register Field, select a column to map 

the Register field value to the Lookup column value. Values must match to return a result.

 8. Click the Preview button. The Preview table on the right will populate with data.

 9. Click the Save button. Once saved, the Lookup Driver displays in the Lookup Drivers page.
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IMPORTANT: The Save button displays once the Preview table is populated 

successfully.

Edit Lookup Drivers

To edit a Lookup Driver, follow the legend and corresponding instructions:
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 1. On the Lookup Driver page, select a Lookup Driver.

 2. Click the Edit button.

 3. Update all relevant criteria.

 4. Click the Preview button.

 5. Click the Save button.

IMPORTANT: The Save button displays once the Preview table is populated 

successfully.

Delete Lookup Drivers

To delete a Lookup Driver, follow the legend and corresponding instructions:

 1. On the Lookup Driver page, select a Lookup Driver.

 2. Click the Delete button.

NOTE: You cannot delete a Lookup Driver that is being used in a formula.
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Formula Wizard
The Formula Wizard provides a guided and intuitive experience for formula creation. It offers 

selectable criteria to help generate specific formulas based on the required data. You can only 

select criteria to which you have security access.

IMPORTANT: Any attribute named in the solution, such as Register Field Names, 

Accounts, Global Drivers, Cube Drivers, Lookup Drivers and Formula Names, must be 

unique from each other.

There is a wide variety of selections and functions available in the Formula Wizard. Review the 

following sections to guide you through the process:

 l Formula Name: This is a required field that can have a maximum of 100 characters. As a 

best practice, create a unique formula name and avoid using the Account Name as the 

Formula Name.

 l Formula Description: This optional field enables you to add a description for your Formula 

Name. It is recommended that you use 100 characters or less.

 l Register Group: The Register Group defaults to All Employees for the Workforce Planning 

configuration or All Records for the Fixed Term Planning and Duration Based Planning 

configurations. If the formula only applies to a filtered data set, select the drop-down menu 

to apply a saved Register filter to pare down the calculated data set and remove 

unnecessary data points.

 l Value Type: Select either Year-To-Date (YTD) to calculate for the cumulative value or 

Periodic to calculate the periodic value.

 l Account: Informs the calculation engine where to place the result amount for a formula 

when calculating a plan.
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 l Scenario Type: Informs the calculation engine which formulas apply to a plan. If the 

formula applies to all scenarios, select All Scenarios. For example, If the formula only 

applies to the budget scenario type, select the budget scenario type. See Plan Data.

NOTE: The Scenario Type defaults to All Scenario Types.

 l Periods: Apply the months you want the formula to be calculated in. You can select all 12 

months, a single month, or any combination of months depending on your planning needs. 

You can also select the time profile.

NOTE: The Periods selection defaults to All Periods.

TIP: For a detailed list of formulas, see Appendix A.

The gray area below your selectable criteria is the Formula Preview. When creating a new 

formula, this area will display No formula to preview. Once you start building your formula, this 

area will dynamically populate a concatenated view of your formula for easier viewing. If the 

formula is too long to fit in the space, the formula text will wrap in format and you can scroll down 

to view the full formula.

Below the gray Formula Preview is the Formula Block area where you are prompted to add 

blocks. The yellow highlighted block is automatically selected so you can freely add blocks and 

operations to your formula.
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There is an About section available for each formula block type that gives a brief explanation of 

how each block functions.The building block options are:

 l Operators: These are the mathematical symbols above each of the building block options, 

like the equal sign. Click the operator you need, and it will display in the Formula Block 

area.

 l Text: In the Text Field, you can type in text, numbers or certain operators listed in the About 

Text description. You can also type in formulas or parts of formulas such as global drivers or 

functions to be converted into blocks.

A wildcard or specific string data can be entered as a text block by wrapping it in quotation 

marks, inserting the LIKE function, and then entering a second string data block with a 

percentage prefix.

Example: "Test String" LIKE "%string"

Before you input text, you can use the Separator, Date Format and Number Format drop-

down menus to override your default culture settings. This is helpful if you are trying to copy 

in formulas that use a different culture setting.
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NOTE: The default value of the Separator, Date Format, and Number Format 

drop-down menus is based on your culture settings.

IMPORTANT: When you type in a formula, each block within that typed formula 

has to match the specific formula block naming or a validation will display. For 

example, if you type in the formula, FTE+Salaries, but the Register column name 

is Salary, the formula will not populate until all blocks are valid.
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 l Register: The Register tab enables you to select from any of the columns you have 

permission to view. When you add a named block, the value tied to the Register field is 

used in the formula creation. You can also pin all the fields available in the Register tab by 

clicking the Pin button, and they will display in the Recently Pinned pane for easy reuse 

when building your formulas.

 l Globals: The Globals tab enables you to select from any of the Global Drivers that were 

previously imported. When you add a named block, the value tied to the Global Driver is 

used in the formula calculation. You can also pin all the fields available in the Globals tab by 

clicking the Pin button, and they will display in the Recently Pinned pane for easy reuse 

when building your formulas.
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 l Cube: The Cube tab enables you to select from any of the Cube drivers added to the 

solution. When you add a named block, the value tied to the Cube driver is used in the 

formula calculation. You can also pin all the fields available in the Cube tab by clicking the 

Pin button and they will display in the Recently Pinned pane for easy reuse when building 

your formulas.
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 l Lookup: The Lookup tab enables you to select from any of the Lookup drivers added to the 

solution. When you add a named block, the value tied to the Lookup driver is used in the 

formula calculation. You can also pin all the fields available in the Lookup tab by clicking the 

Pin button and they will display in the Recently Pinned pane for easy reuse when building 

your formulas.

 l Functions: The function block content enables you to select from several different 

functions that help define your formula.

 o DateDiff(day): Returns the number of day boundaries between two dates.

 o DateDiff(month): Returns the number of months between two dates.

 o DateDiff(year): Returns the number of years between two dates.

 o IIF: Returns a value based on the condition of a true or false statement.

 o AND: Displays or uses records if all the conditions are true.

 o OR: Displays or includes records if any of the conditions are true.

 o CurrentPeriod: Applies the current month in the formula.
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 o IsNull: Evaluates if there are blank values in a calculation.

 o RollingPeriod: Returns the number of periods in a plan.

 o CurrentYear: Returns the current year in the formula.

 o LIKE: Checks whether a text value matches a pattern using wildcards.

You can reference the definition for each function to the right of the function blocks in the 

About Functions pane.

 l Accounts: The Account Library enables you to include formulas that are tied to a specific 

account as a dependency in a formula you are creating. In the Account Name drop-down 

menu, select an account name and a view-only field of the selected account information 

such as Account, Calculation Name and Register Group populates. Click the Add Block 

button to add that formula as a block into an active formula.

After you have made all your selections and built your formula using the block options available, 

you can view your formula in the Formula Preview and additional buttons will display in your 

Formula Builder area:
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 l To move a block to the left, select it and then click the Move Left button.

 l To move a block to the right, select it and then click the Move Right button.

 l To delete a block no longer needed in your formula, select it and then click the Delete 
Block button.

 l To remove all blocks, click the Clear All Blocks button.

The Recently Used or Recently Pinned pane will automatically populate based on the blocks you 

have used or pinned. This enables you to easily reference blocks that are frequently used. 

Clicking the toggle button to switch between the Recently Used and Recently Pinned panes gives 

you the flexibility to set your own preferences when building formulas. You can select a block from 

either list to insert it into the formula you are working on.

NOTE: After creating, copying, or editing a formula, the last pinned information will 

remain.
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Create a New Formula

To create a new formula, follow the legend and the corresponding instructions:
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 1. Click the New button.

 2. Name the formula. This step is required.

 3. (Optional) Enter a formula description.

 4. From the Register Group drop-down menu, select a Register Group.

 5. From the Value Type drop-down menu, select a Value Type.

 6. From the Account drop-down menu, select an Account.

 7. Click All Scenario Types to select a Scenario Type.

 8. Click Period(s) Selected to select a periods.

 9. Build your formula blocks by choosing from operators, Text, Register, Globals, Cube, 

Lookup, Functions or Accounts. When selected, each block is automatically added to the 

end of the formula unless otherwise designated.

 10. After you have entered text in the Text Field or selected a block from the Register, Globals 

or Cube option, click the Add to Formula button. The block will populate in the formula 

preview.

 11. Click the Save button.

NOTE: After you save a formula a dialog displays and provides an option to Return to 

Formula Library or Create Another Formula. If you select Create Another Formula, the 

Register Group field in the Formula Wizard resets automatically. For Workforce 

Planning, it resets to All Employees. For Fixed Term Planning and Duration Based 

Planning, it resets to All Records.

Edit Formulas

To edit a formula, follow the legend and the corresponding instructions:
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 1. Select an existing formula from the formulas page.

 2. Click the Edit button. The Formula Wizard will open enabling you to make any updates.

 3. Click the Save button.

Copy Formulas

To copy a formula, follow the legend and the corresponding instructions:
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 1. Select an existing formula from the grid.

 2. Click the Copy button. The Formula Wizard will open, enabling you to make any updates.

NOTE: When a formula is copied, the Formula Name adds the word Copy to the 

end of it, and the Formula Description is updated to Copy. Ensure the Formula 

Name is updated before saving.

 3. Click the Save button.

Delete Formulas

You can only delete formulas if you have Manage Formulas security access. See Security.

To delete a formula, follow the legend and the corresponding instructions:
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 1. Hover your cursor over the Formulas menu.

 2. In the drop-down menu, select Formulas.

 3. Select a formula from the formula table.

 4. Click the Delete button.

Data in an active or unlocked plan linked to a formula will remain until the next time a calculation is 

run. If a plan is locked and you delete a formula that is linked to the locked plan, the data will not 

change.

NOTE: You cannot delete a formula that is being used within another formula as a 

dependency.

Enable Formulas

You can modify the enablement and execution of formulas in the Formula dashboard to determine 

how formulas are used. You can only enable formulas if you have Manage Formulas security 

access. When you create, copy or edit a formula, the enable column is automatically set to 

enabled.
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NOTE: You cannot disable  the final active formula when its account is still used as a 

dependency.

To enable a formula, follow the legend and corresponding instructions:

 1. Select a formula.

 2. In the Enable column, select the checkbox.

IMPORTANT: You cannot disable a formula that is being used within another formula as 

a dependency or enable a formula that contains a disabled formula.
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Plan Data
Plan data is the calculated output of the Line Item Modeling solutions. Plans are produced when 

your data is calculated using the formulas you create.

Plans Dashboard

The Plans dashboard features all the functions for managing and running calculations on plans. 

Within the dashboard, you can see a table of created plans and all criteria related to each plan. 

You can also perform and view the following actions depending on your security access:

 l Create a New Plan

 l Recalculate a Plan

 l View Plan

 l Lock or Unlock Plan

 l Delete Plan

 l Copy Plan
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 l Edit Plan

 l Plan Log

 l Connector Business Rule

 l Data Adapter

 l Select Workflow

Create a New Plan
To create a new plan, follow the legend and corresponding instructions:
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 1. Hover your cursor over the Register menu.

 2. In the drop-down menu, select Calculate & Analyze.

 3. Click the New button.

 4. Enter a plan name in the text box.

NOTE: Do not include special characters in the plan name, as the data adapter 

will not run if the plan name contains them.

 5. Select Scenario Type. A dialog box displays with available options.

NOTE: Selecting your scenario type before selecting your scenario filters down 

the available scenario options. If you select your scenario before selecting your 

scenario type, you'll see all the scenario base members except for actuals.

 6. Select Scenario. A dialog box displays with available options.

 7. Select Start Year. A drop-down menu will display years.

 8. Select Period. A dialog box displays available months.

 9. Select the number of periods using the drop-down menu. You can select up to 120 months.

 10. Click the Create Plan button. After the table is created, a CALCULATE button displays.

 11. Click the CALCULATE button. A data management job displays showing the progression 

of the formulas being calculated. When the calculation is complete and the data 

management job closes, you have to refresh the application to display your results.

NOTE: The Windows Application refreshes the page automatically.

Line Item Modeling Guide 106

Plan Data



NOTE: If you do not populate all the necessary criteria, a dialog box displays reminding 

you to fill out any remaining items.

To filter your results, you can use the filter editor component. See Manage Filters.

Plan data generates the columns in the table based on the criteria chosen, including any saved 

formulas. After the calculation is complete, you can navigate back to the Plans dashboard and 

your new plan is listed in the table with all of the chosen criteria including Last Calculation Date 

and Last Modified By. When you have other Register columns with member definitions assigned, 

those columns show up in the calculated plan data.

Recalculate a Plan
If you update a formula or edit Register or plan data, you can recalculate a saved plan. If you 

upload new plan data, you will need to refresh the page. You might consider recalculating when:

 l Adding a new employee to the Register

 l Updating the base wage of the employee

 l Updating a Global Driver

 l Updating an existing formula
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NOTE: If you delete all Register data and then try to recalculate a plan, a dialog box 

displays reminding you to populate Register data. When there is no Register data, the 

Calculate button does not display.

To recalculate a plan, follow these steps:

 1. Navigate to the Plans dashboard.

 2. Select the plan you want to run a new calculation on.

 3. Click the View button.

 4. Click the CALCULATE button.

When the calculation is complete, the plan data populates and overwrites the previous data.

View Plan
To view a saved plan, follow the legend and corresponding instructions:
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 1. Hover your cursor over the Register menu.

 2. In the drop-down menu, select Calculate & Analyze.

 3. Selected a previously created plan.

 4. Click the View button.

A new page opens and you can view the calculated data of the selected plan. 

There are several ways you can filter the plan data:

 l Use the Select Columns button to filter and view all the Register columns you have access 

to within a selected plan.

 l Select the context menu  icon on a column header to sort by descending or ascending 

order or use filter drop-down menu to set specifications.

 l Select a date range to preview using the Start and End drop-down menus. After selecting 

the date ranges, select the Apply Dates icon.

NOTE: If you do not have security access to calculate data or if all Register data is 

deleted, the CALCULATE button is not visible on the View Plan page. The 

CALCULATE button is unavailable if the plan is locked.
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Lock or Unlock Plan
Once a plan is created and has data, you can lock or unlock plans depending on your security 

access. Locking a plan prevents any calculations from being made. Unlocking a plan enables you 

to run a calculation.

To lock or unlock a plan, follow the legend and corresponding instructions:

 1. Hover your cursor over the Register menu.

 2. In the drop-down menu, select Calculate & Analyze.

 3. Select a plan.

 4. Click the Lock button to lock the plan or click the Unlock button to unlock the plan. The 

Status column will update.

If the plan is locked and you click the View button, the following page will not show the 

CALCULATE button. If the plan is unlocked and you click the View button, the CALCULATE 

button will be available.
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NOTE: If you do not have security access to lock and unlock plan data, the Lock or 

Unlock buttons are not visible.

Delete Plan
If you want to delete a plan, it must be unlocked and finished calculating. If you try to delete a 

locked plan, a dialog box informs you that it cannot be removed. If you try and delete a plan that is 

calculating, a validation message informs you that calculations are in progress.

To delete a plan, follow the legend and corresponding instructions:

 1. Hover your cursor over the Register menu.

 2. In the drop-down menu, select Calculate & Analyze.

 3. Select a plan.

 4. Click the Delete button.

A dialog box displays to confirm if you want to proceed with removing the selected plan data. If 

there is no data in the plan, a dialog box will not display.
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Copy Plan
You can copy a plan to utilize another plan's selected criteria. You can copy a locked plan 

because the copy function only copies the plan criteria.

To copy a plan, follow the legend and corresponding instructions:

 1. Hover your cursor over the Register menu.

 2. In the drop-down menu, select Calculate & Analyze.

 3. Select a plan.

 4. Click the Copy button.

 5. (Optional) Rename the plan.
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NOTE: When a plan is copied, the word Copy is added to the end of the Plan 

Name.

 6. (Optional) Update plan criteria.

 7. Click the Create Plan button.

 8. Click the CALCULATE button.

Edit Plan
You can edit a plan to update any of the plan criteria and re-run a calculation. You can only edit an 

unlocked plan.

To edit a plan, follow the legend and corresponding instructions:
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 1. Hover your cursor over the Register menu.

 2. In the drop-down menu, select Calculate & Analyze.

 3. Select a plan.

 4. Click the Edit button.

 5. Update plan criteria.

 6. Click the Update Plan button.

 7. Click the CALCULATE button.

Plan Log
The plan log records information from the last calculation of a plan. You can use the plan log to 

audit your plans and verify what entities were calculated for.

To view a plan log, follow the legend and corresponding instructions:
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 1. Hover your cursor over the Register menu.

 2. In the drop-down menu, select Calculate & Analyze.

 3. Select a plan.

 4. Click the Plan Log button.

A new page will open, and you can view the filter groups calculated based on the security 

assigned, what time the plan was last calculated and who calculated it. The plan log will also 

display the number of calculated rows and total rows in the plan.

Connector Business Rule
A connector business rule is created automatically when you install the solution and captures 

relevant column information the entity member definition is assigned to within a plan. That plan 

data can then be directly imported to a OneStream workflow profile. You will need a 

corresponding Data Source, Transformation Rule, and Workflow Profile to connect the plan 

data to the workflow. For example, if you create a Workflow Profile with a scenario type that does 

not match the selected plan, the data will not populate and you will have to select the correct 

scenario type.

To access the connector business rule, go to Application > Business Rules > Connector and 

then locate your planning configuration plan data connector instance. See the example below for 

the first instance of the Workforce Planning configuration:
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Select Workflow
The Line Item Modeling solution enables you to launch multiple workflows for multiple time 

periods to export plan data into a workflow and run the plan data through the entire workflow 

process and into a cube. The data in the plan table will integrate with the Workflow based on 

specific settings around the Can Load Unrelated Entities profile property and the Substitution Text 

Strings in the Workflow Profile. When the Can Load Unrelated Entities profile property is set to 

True, then the processing of the Plan Data to the Workflow will reference the Substitution Text 

Settings populated with LIMEntity=MemberDefinition, and will import data based on security 

defined in the solution. When the Can Load Unrelated Entities profile property is set to False, then 

the processing of the Plan Data to the Workflow will reference Entity Assignment tab within the 

Workflow Profile and match Entities that exist in the plan table to know which Entities to import 

(this will be done for users that have write access for the respective Entities).

NOTE: Workflow security defaults to the Execution Group to align with the group used 

during workflow execution.

Once data is exported, you can navigate to OnePlace > Workflow and select the periods that 

were loaded to view the data in the import step.

NOTE: You must have the Manage Plans security permission to use the select workflow 

feature.
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To export data into a workflow, follow the image and corresponding instructions:
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 1. Hover your cursor over the Register menu.

 2. In the drop-down menu, select Calculate & Analyze.

 3. Select a plan.

 4. Click the View button.

 5. Click the Process button.

 6. In the Cube Root Workflow drop-down menu, select a workflow.

 7. Select a Workflow checkbox.

NOTE: You can select multiple workflows.

 8. Select a Period checkbox.

NOTE: You can select multiple periods.

 9. Click the Process button. A message box displays how many rows were loaded for each 

period.

Data Adapter
When a plan has calculated data, a permitted user can run a data adapter query to access the 

plan. You can do so by going to the Application tab, clicking on Workspaces, opening the 

Workforce Planning  Workspace, expanding Dashboarding > Data Adapters, and selecting the 

da_GetPlanData_LIM data adapter.

NOTE: The Data Adapter executes the designated security method to comply with all 

solution-specific security configurations within the Line Item Modeling solution. Security 

is a critical component of the adapter, ensuring that data accessed outside the solution 

continues to adhere to the established security protocols applied to the data set.
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Once the data adapter is selected, click on Run button on the toolbar. Doing so will offer 

parameters for you to select the specific Plan Name, option to preview the data, and it's 

corresponding Start and End dates. Doing so will provide the resulting query in the Data Preview 

along with the total number of rows based on the query parameters.
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Workforce Planning FUTA Formula 
Use Case
The following use case provides a detailed look into using formulas in the Workforce Planning 

configuration.

Scenario: Build a set of formulas to determine if the federal tax amount applies to an employee in 

a specific month. Federal tax calculation compares total monthly earnings of any employee to the 

federal tax limit.

Role: Implementer, Administrator

Benefits: Formulas can be individually created and the accounts applied to the formulas can be 

used as dependencies or building blocks for more advanced formulas to calculate more complex 

data.

You need to create a formula to calculate each category of earnings an employee could have, 

then populate the federal tax limit formula. You can create the following example formulas:

 l Monthly Salary Formula

 l Bonus Calculation Formula

 l Merit Calculation Formula

 l Total Monthly Salary

 l Year-To-Date Salary Formula

 l Year-To-Date Salary - Tax Limit Formula
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 l Periodic - (YTD-FUTA Limit) Formula

 l FUTA Formula

IMPORTANT: There are many ways of creating formulas based on your configured 

Register fields, Global Drivers, Cube Drivers, and Register Field Groups. These 

formulas are examples to detail a particular use case.

Solution Setup
Before you can create the formulas for this use case, you have to set up the solution by installing 

the Workforce Planning configuration. Follow these instructions for an example setup:

 1. Set up the solution by using the Setup Wizard.

 l Register fields that are needed include: Salary (this field could be a yearly amount), 

FTE (this helps determine if the salary is dedicated to one Entity, Region, or Cost 

Center or should be split between multiple). For additional information, see Register.

Example:
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 l Ensure there is an account in your import that can hold your monthly salary amounts. 

In this example, Account Name 50200 and Account Description of Monthly Salary are 

used. For additional information, see Accounts.

Example:
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 l Security needs to be configured in order to complete the setup wizard. Assign as 

necessary. For additional information, see Security.

 2. Load Register Data. For additional information, see Import and Modify.

Example:
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 3. Import Global Drivers. For additional information, see Global Drivers.

Example:

Monthly Salary Formula

The monthly salary formula is determined by the Full Time Equivalent (FTE) amount multiplied by 

the salary and divided by 12.
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There are two different options for creating this formula:

 l Option 1: Select each formula block.

 l Option 2: Type the formula in the text field of the Text tab.

Option 1

Follow these instructions to create this formula by selecting each block:

 1. Populate the formula criteria:

 l Formula Name: Monthly Salary

 l (Optional) Formula Description

 l Register Group: All Employees

 l Value Type: Periodic

 l Account: 50200 - Monthly Salary
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 l Scenario Type: All Scenarios

 l Periods: All periods selected

 2. Click the Register tab, select FTE from the drop-down menu and click the Add To Formula 

button.

 3. Click the * operator block.

 4. Click the Register tab, select Salary from the drop-down menu and click the Add To 
Formula button.

 5. Click the / operator block.

 6. Click the Text tab, type 12 in the text field and click the Add To Formula button.

 7. Click the Save button. You will receive a confirmation message with the option to create 

another formula or return to the formula library.

Option 2

Follow these instructions to create this formula by typing the formula in the Text tab:

 1. Populate the formula criteria:

 l Formula Name: Monthly Salary

 l (Optional) Formula Description

 l Register Group: All Employees

 l Value Type: Periodic

 l Account: 50200 - Monthly Salary
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 l Scenario Type: All Scenarios

 l Periods: All periods selected

 2. Click the Text tab, type FTE*Salary/12 in the text field and click the Add To Formula 

button.

 3. Click the Save button. You will receive a confirmation message with the option to create 

another formula or return to the formula library.

Bonus Calculation Formula

The bonus calculation formula uses a conditional IIF statement to determine if the CurrentPeriod 

is equal to the bonus period as defined in the Global Drivers as well as multiplying salary and 

bonus percent.

There are two different options for creating this formula:

 l Option 1: Select each formula block.

 l Option 2: Type the formula in the text field of the Text tab.

Option 1

Follow these instructions to create this formula by selecting each block:
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 1. Populate the formula criteria:

 l Formula Name: Bonus Calc

 l (Optional) Formula Description

 l Register Group: All Employees

 l Value Type: Periodic

 l Account: 50220 - Bonus

 l Scenario Type: All Scenarios

 l Periods: All periods selected

 2. Click the Functions tab and select the IIF block.

 3. Click the Functions tab and select the CurrentPeriod block.

 4. Click the = operator block.

 5. Click the Globals tab, select Bonus Per from the drop-down menu and click the Add To 
Formula button.

 6. Click the , operator block.

 7. Click the Register tab, select Salary from the drop-down menu and click the Add To 
Formula button.

 8. Click the * operator block.

 9. Click the Register tab, select Bonus from the drop-down menu and click the Add To 
Formula button.

 10. Click the , operator block.

 11. Click the Text tab, type 0 in the text field and click the Add To Formula button.
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 12. Click the Save button. You will receive a confirmation message with the option to create 

another formula or return to the formula library.

Option 2

Follow these instructions to create this formula by typing the formula in the Text tab:

 1. Populate the formula criteria:

 l Formula Name: Bonus Calc

 l (Optional) Formula Description

 l Register Group: All Employees

 l Value Type: Periodic

 l Account: 50220 - Bonus

 l Scenario Type: All Scenarios

 l Periods: All periods selected

 2. Click the Text tab, type IIF(CurrentPeriod=Bonus Per,Salary*Bonus,0) in the text field 

and click the Add To Formula button.

 3. Click the Save button. You will receive a confirmation message with the option to create 

another formula or return to the formula library.

Merit Calculation Formula

The merit calculation formula uses a conditional IIF statement to determine if the CurrentPeriod is 

greater than or equal to merit increase period. If that value is true, the monthly salary will be 

multiplied by the merit rate.
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There are two different options for creating this formula:

 l Option 1: Select each formula block.

 l Option 2: Type the formula in the text field of the Text tab.

Option 1

Follow these instructions to create this formula by selecting each block:

 1. Populate the formula criteria:

 l Formula Name: Merit Calc

 l (Optional) Formula Description

 l Register Group: All Employees

 l Value Type: Periodic

 l Account: 50250 - Merit

 l Scenario Type: All Scenarios

 l Periods: All periods selected

 2. Click the Functions tab and select the IIF block.

 3. Click the Functions tab and select the CurrentPeriod block.

 4. Click the >= operator block.

 5. Click the Globals tab, select Merit Inc Per from the drop-down menu and click the Add To 
Formula button.
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 6. Click the , operator block.

 7. Click the Accounts tab, select 50200 from the Account Name drop-down menu, select the 

Monthly Salary formula and click the Add Block button.

 8. Click the * operator block.

 9. Click the Globals tab, select Merit Rate Ex from the drop-down menu and click the Add To 
Formula button.

 10. Click the , operator block.

 11. Click the Text tab, type 0 in the text field and click the Add To Formula button.

 12. Click the Save button. You will receive a confirmation message with the option to create 

another formula or return to the formula library.

Option 2

Follow these instructions to create this formula by typing the formula in the Text tab:

 1. Populate the formula criteria:

 l Formula Name: Merit Calc

 l (Optional) Formula Description

 l Register Group: All Employees

 l Value Type: Periodic

 l Account: 50250 - Merit

 l Scenario Type: All Scenarios

 l Periods: All periods selected

 2. Click the Text tab, type IIF(CurrentPeriod>=Merit Incr Per,A#50200*Merit Rate Ex,0) in 

the text field and click the Add To Formula button.
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 3. Click the Save button. You will receive a confirmation message with the option to create 

another formula or return to the formula library.

Total Monthly Salary

After you have created a monthly salary, bonus, and merit formula, you can create a formula that 

adds all of those calculations together. This formula utilizes the IsNull block from the Functions tab 

which determines if there are blank values for a specific period in the calculated results from the 

monthly salary, bonus, and merit formulas. You can enter a 0 in the IsNull calculation to replace 

any blank values to make sure there is no impact to the overall calculation. For example, if a 

bonus calculation for a given month is $1000 and the IsNull function is used with a value of 0 for all 

other periods, the bonus calculation will remain at $1000. If you use a value of 1 in the IsNull 

calculation, then the bonus calculation for the year would be $1,011 (based on the 11 months 

carrying a 1 dollar value).

There are two different options for creating this formula:

 l Option 1: Select each formula block.

 l Option 2: Type the formula in the text field of the Text tab.

Option 1

Follow these instructions to create this formula by selecting each block:
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 1. Populate the formula criteria:

 l Formula Name: Total Monthly Salary

 l (Optional) Formula Description

 l Register Group: All Employees

 l Value Type: Periodic

 l Account: 50299 - Monthly Total Salary

 l Scenario Type: All Scenarios

 l Periods: All periods selected

 2. Click the Functions tab and select the IsNull block.

 3. Select the vertical ellipses to the right of the IsNull block.

 4. Click the Accounts tab, select 50200 from the Account Name drop-down menu, select the 

Monthly Salary formula and click the Add Block button.

 5. Select the vertical ellipses after the next comma block.

 6. Click the Text tab, type 0 in the text field and click the Add To Formula button.

 7. Select the vertical ellipses after the next comma block.

 8. Click the + operator block.

 9. Click the Functions tab and select the IsNull block.

 10. Select the vertical ellipses to the right of the IsNull block.

 11. Click the Accounts tab, select 50220 from the Account Name drop-down menu, select the 

BonusCalc formula and click the Add Block button.

 12. Select the vertical ellipses after the next comma block.

 13. Click the Text tab, type 0 in the text field and click the Add To Formula button.
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 14. Select the vertical ellipses after the next comma block.

 15. Click the + operator block.

 16. Click the Functions tab and select the IsNull block.

 17. Select the vertical ellipses to the right of the IsNull block.

 18. Click the Accounts tab, select 50250 from the Account Name drop-down menu, select the 

Merit Calc formula and click the Add Block button.

 19. Select the vertical ellipses after the next comma block.

 20. Click the Text tab, type 0 in the text field and click the Add To Formula button.

 21. Click the Save button. You will receive a confirmation message with the option to create 

another formula or return to the formula library.

Option 2

Follow these instructions to create this formula by typing the formula in the Text tab:

 1. Populate the formula criteria:

 l Formula Name: Total Monthly Salary

 l (Optional) Formula Description

 l Register Group: All Employees

 l Value Type: Periodic

 l Account: 50299 - Monthly Total Salary

 l Scenario Type: All Scenarios

 l Periods: All periods selected

 2. Click the Text tab, type IsNull(A#50200,0)+IsNull(A#50220,0)+IsNull(A#50250,0) in the 

text field and click the Add To Formula button.
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 3. Click the Save button. You will receive a confirmation message with the option to create 

another formula or return to the formula library.

Year-To-Date Salary Formula

The year-to-date salary formula is similar to the total monthly salary formula except that it 

calculates a year-to-date value type instead of a periodic.

Follow these instructions to create a year-to-date salary formula using example data and 

dependency formulas:

 1. Select the Total Monthly Salary formula from the formula dashboard and click the Copy 

button.

 2. Update the Formula Name to YTD Salary.

 3. From the Value Type drop-down menu, select YTD.

 4. From the Account drop-down menu, select 50201 - YTD Salary.

 5. Click the Save button. You will receive a confirmation message with the option to create 

another formula or return to the formula library.

Year-To-Date Salary - Tax Limit Formula

The year-to-date salary - tax limit formula determines the difference between the YTD salary and 

the FUTA limit.
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There are two different options for creating this formula:

 l Option 1: Select each formula block.

 l Option 2: Type the formula in the text field of the Text tab.

Option 1

Follow these instructions to create this formula using example data and dependency formulas:

 1. Populate the formula criteria:

 l Formula Name: YTD  - FUTA Limit

 l (Optional) Formula Description

 l Register Group: All Employees

 l Value Type: Periodic

 l Account: 50202-YTD-FUTA Limit

 l Scenario Type: All Scenarios

 l Periods: All periods selected

 2. Click the Functions tab and select the IsNull block.

 3. Select the vertical ellipses to the right of the IsNull block.

 4. Click the Accounts tab, select 50202 from the Account Name drop-down menu, select the 

YTD Salary formula and click the Add Block button.

 5. Select the vertical ellipses after the next comma block.
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 6. Click the Text tab, type 0 in the text field and click the Add To Formula button.

 7. Select the vertical ellipses after the next parentheses block.

 8. Click the - operator block.

 9. Click the Globals tab, select the Federal Tax Limit from the drop-down menu and click the 

Add To Formula button.

 10. Click the Save button. You will receive a confirmation message with the option to create 

another formula or return to the formula library.

Option 2

Follow these instructions to create this formula by typing the formula in the Text tab:

 1. Populate the formula criteria:

 l Formula Name: YTD - FUTA Limit

 l (Optional) Formula Description

 l Register Group: All Employees

 l Value Type: Periodic

 l Account: 50202 - YTD-Futa Limit

 l Scenario Type: All Scenarios

 l Periods: All periods selected

 2. Click the Text tab, type IsNull(A#50201,0)-Federal Tax Limit in the text field and click the 

Add To Formula button.

 3. Click the Save button. You will receive a confirmation message with the option to create 

another formula or return to the formula library.
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Periodic - (YTD-FUTA Limit) Formula

The Periodic - (YTD - FUTA Limit) formula determines the difference between the total monthly 

salary formula and the year-to-date - FUTA Limit formula.

There are two different options for creating this formula:

 l Option 1: Select each formula block.

 l Option 2: Type the formula in the text field of the Text tab.

Option 1

Follow these instructions to create this formula using example data and dependency formulas:

 1. Populate the formula criteria:

 l Formula Name: Periodic - (YTD - FUTA Limit)

 l (Optional) Formula Description

 l Register Group: All Employees

 l Value Type: Periodic

 l Account: 50203 - Periodic - (YTD - FUTA Limit)

 l Scenario Type: All Scenarios

 l Periods: All periods selected

 2. Click the Functions tab and select the IsNull block.
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 3. Select the vertical ellipses to the right of the IsNull block.

 4. Click the Accounts tab, select 50299 from the Account Name drop-down menu, select the 

Total Monthly Salary formula and click the Add Block button.

 5. Select the vertical ellipses after the next comma block.

 6. Click the Text tab and type 0 in the text field and click the Add To Formula button.

 7. Select the vertical ellipses after the next parentheses block.

 8. Click the - operator block.

 9. Click the Functions tab and select the IsNull block.

 10. Select the vertical ellipses to the right of the IsNull block.

 11. Click the Accounts tab, select 50201 from the Account Name drop-down menu, select the 

YTD Salary - Tax Limit formula and click the Add Block button.

 12. Select the vertical ellipses after the next comma block.

 13. Click the Text tab, type 0 in the text field and click the Add To Formula button.

 14. Select the vertical ellipses after the next parentheses block.

 15. Click the - operator block.

 16. Click the Globals tab, select the Federal Tax Limit from the drop-down menu and click the 

Add To Formula button.

 17. Click the ) operator block.

 18. Click the Save button. You will receive a confirmation message with the option to create 

another formula or return to the formula library.

Option 2

Follow these instructions to create the formula by typing  in the Text tab:
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 1. Populate the formula criteria:

 l Formula Name: Periodic - (YTD - FUTA Limit)

 l (Optional) Formula Description

 l Register Group: All Employees

 l Value Type: Periodic

 l Account: 50203 - Periodic - (YTD - FUTA Limit)

 l Scenario Type: All Scenarios

 l Periods: All periods selected

 2. Click the Text tab, type IsNull(A#50299,0)-(IsNull(A#50201,0)-Federal Tax Limit) in the 

text field and click the Add To Formula button.

 3. Click the Save button. You will receive a confirmation message with the option to create 

another formula or return to the formula library.

FUTA Formula

The FUTA formula utilizes two IIF statements. The first is used to determine if the year-to-

date salary is less than or equal to the federal tax limit. If it is, then the calculation will apply the 

total monthly salary multiplied by the FUTA rate. If the first IIF statement is false and the federal 

tax limit is surpassed, then the calculation will apply the difference between the total monthly 

salary and the result of the (YTD Salary - Tax Limit) value multiplied by the FUTA rate.

There are two different options for creating this formula:

Line Item Modeling Guide 142

Workforce Planning FUTA Formula Use Case



 l Option 1: Select each formula block.

 l Option 2: Type the formula in the text field of the Text tab.

Option 1

Follow these instructions to create this formula using example data and dependency formulas:

 1. Populate the formula criteria:

 l Formula Name: FUTA

 l (Optional) Formula Description

 l Register Group: All Employees

 l Value Type: Periodic

 l Account: 50000 - FUTA

 l Scenario Type: All Scenarios

 l Periods: All periods selected

 2. Click the Functions tab and select the IIF block.

 3. Click the Accounts tab, select 50201 from the Account Name drop-down menu, select the 

YTD Salary formula and click the Add Block button.

 4. Click the <= operator.

 5. Click the Globals tab, select Federal Tax Limit from the drop-down menu and click the 

Add To Formula button.

 6. Click the , operator block.

 7. Click the Globals tab, select Federal Tax Rate from the drop-down menu and click the Add 
To Formula button.

 8. Click the * operator block.
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 9. Click the Accounts tab, select 50299 from the Account Name drop-down menu, select the 

Total Monthly Salary formula and click the Add Block button.

 10. Select the vertical ellipses after the next comma block.

 11. Click the Functions tab and select the IIF block.

 12. Click the Accounts tab, select 50203 from the Account Name drop-down menu, select the 

Periodic-(YTD-FUTA Limit) formula and click the Add Block button.

 13. Click the < operator block.

 14. Click the Text tab, and type 0 in the text field and click the Add To Formula button.

 15. Select the vertical ellipses after the next comma block.

 16. Click the , operator block.

 17. Click the Accounts tab, select 50203 from the Account Name drop-down menu, select the 

Periodic-(YTD-FUTA Limit) formula and click the Add Block button.

 18. Click the * operator block.

 19. Click the Globals tab, select Federal Tax Rate from the drop-down menu and click the Add 
To Formula button.

 20. Click the ) operator block.

 21. Click the Save button. You will receive a confirmation message with the option to create 

another formula or return to the formula library.

Option 2

Follow these instructions to create this formula by typing the formula in the Text tab:
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 1. Populate the formula criteria:

 l Formula Name: FUTA

 l (Optional) Formula Description

 l Register Group: All Employees

 l Value Type: Periodic

 l Account: 50000 - FUTA

 l Scenario Type: All Scenarios

 l Periods: All periods selected

 2. Click the Text tab, and type IIF(A#50201<=Federal Tax Limit,Federal Tax 
Rate*A#50299,IIF(A#50203<0,0,A#50203*Federal Tax Rate)) in the text field and click 

the Add To Formula button.

 3. Click the Save button. You will receive a confirmation message with the option to create 

another formula or return to the formula library.
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Help and Miscellaneous 
Information

Access the help documentation. 

Display Settings
OneStream Solutions frequently display multiple elements for data entry and analysis. We 

recommend you set your screen resolution to a minimum of 1920 x 1080 for optimal form and 

report rendering. Adjust the Windows System Display text setting to 100% and do not apply 

Custom Scaling options.

Package Contents and Naming Conventions
The package file name contains multiple identifiers that correspond with the platform. Renaming 

any of the elements contained in a package is discouraged in order to preserve the integrity of the 

naming conventions.

Example Package Name: LIM_PV9.0.0_SV201_PackageContents.zip
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Identifier Description

LIM Solution ID

PV9.0.0 Minimum Platform version required to run solution

SV2.0.1 Solution version

PackageContents File name

OneStream Solution Modification 
Considerations
A few cautions and considerations regarding the modification of OneStream Solutions:

 l Major changes to business rules or custom tables within a OneStream Solution will not be 

supported through normal channels as the resulting solution is significantly different from 

the core solution.

 l If changes are made to any dashboard object or business rule, consider renaming it or 

copying it to a new object first. This is important because if there is an upgrade to the 

OneStream Solution in the future and the customer applies the upgrade, this will overlay 

and wipe out the changes. This also applies when updating any of the standard reports and 

dashboards.
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 l If modifications are made to a OneStream Solution, upgrading to later versions will be more 

complex depending on the degree of customization. Simple changes such as changing a 

logo or colors on a dashboard do not impact upgrades significantly. Making changes to the 

custom database tables and business rules, which should be avoided, will make an 

upgrade even more complicated.
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Appendix A: Workforce Planning 
Formulas
The following table is a detailed list of some Workforce Planning sample formulas.

Formula Description Calculation Logic Calculation Definition

Monthly 

Salary

This is the 

amount of 

money an 

employee 

earns in a 

month.

FTE*Salary/12 FTE*Salary/12

Bonus This is an extra 

payment given 

to an 

employee on 

top of their 

regular salary.

IIF

(CurrentPeriod=Bonus 

Per,Salary*

Bonus,0)

IIF(CurrentPeriod=Bonus 

Per,Salary*Bonus,0)
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Formula Description Calculation Logic Calculation Definition

Merit This often 

refers to a 

system where 

pay increases 

are based on 

employee 

performance.

IIF

(CurrentPeriod>=Merit 

Incr Per,

Monthly Salary*Merit 

Rate Ex,0)

IIF(CurrentPeriod>=Merit Incr 

Per,A#50200*Merit Rate 

Ex,0)

Medical 

Benefits

These are 

health-related 

benefits 

provided by an 

employer.

FTE*Health Ins 

Rate/12

FTE*Health Ins Rate/12

Workers 

Comp

This insurance 

type pays for 

medical care 

and physical 

rehabilitation 

of employees 

injured on the 

job.

Workers Comp 

Rate*Monthly 

Salary

IIF(A#50200>0,Workers 

Comp Rate*A#50200,0)
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Formula Description Calculation Logic Calculation Definition

Disability This insurance 

type pays a 

portion of an 

employee's 

salary for a 

period of time 

if they are 

unable to work 

due to injury or 

illness.

Disb Ins Rate*Monthly 

Salary

A#50200*Disb Ins Rate
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Formula Description Calculation Logic Calculation Definition

FUTA This is short 

for Federal 

Unemploymen

t Tax Act, 

which is a tax 

that employers 

pay to the 

federal 

government to 

fund state 

workforce 

agencies. 

These 

agencies 

provide 

unemployment 

benefits to 

people who 

have lost their 

jobs.

IIF(Total YTD 

Salary<=Federal Tax 

Limit,Federal Tax 

Rate*Total 

Monthly Salary,IIF

(PartialLimitCalc<0,0,

PartialLimitCalc*Feder

al Tax Rate))

IIF(A#50201<=Federal Tax 

Limit,Federal Tax 

Rate*A#50299,IIF

(A#50203<0,0,A#50203*Fed

eral Tax Rate))
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Formula Description Calculation Logic Calculation Definition

SUTA This is short 

for State 

Unemploymen

t Tax Act, 

which is a tax 

that funds 

programs and 

benefits for 

unemployed 

citizens.

SUTA rate*Monthly 

Salary

A#50200*SUTA rate

PTO Vacation This is short 

for paid time 

off, which is a 

policy that 

allows 

employees to 

take time off 

from work 

while still being 

paid.

Vacation 

Factor*Monthly Salary

A#50200*Vacation Factor
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Formula Description Calculation Logic Calculation Definition

PTO Sick This is short 

for paid time 

off, which is a 

policy that 

allows 

employees to 

take time off 

from work due 

to illness, while 

still being paid.

Sick Pay 

Factor*Monthly Salary

A#50200*Sick Pay Factor
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Appendix B: Custom Service 
Factory
The purpose of the Custom Service Factory is to provide a method in which you can add 

customizations to the solution. You can add custom events for components, Dynamic Grid, and 

the SQL.

IMPORTANT: Maintain your assembly as customizations will NOT remain in place 

during a solution upgrade.

NOTE: The Custom Service Factory includes the ability to modify the table view service 

for the register editor. The table name for the register editor is already present in the 

custom service factory code and does not need to be changed. Other areas of the 

Custom Service Factory have placeholders such as my component or my grid name.

Set Up the Custom Service Factory
 1. On the Application tab click Workspaces > Line Item Modeling > Maintenance Units >  

CodeOnly (LIM) > Files.

 2. In the Files folder, click CustomServiceFactory_LIM.zip.
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 3. In the General (File) pane, click Download File and save the file to an appropriate 

location.

 4. On the Application tab, click Tools > Load/Extract.

 5. On the Load tab, locate CustomServiceFactory_LIM.zip using the Select File icons 

and click Open.
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Change Assemblies Setting upon Install
 1. On the Application tab click Workspaces > Line Item Modeling > Maintenance Units >  

CodeOnly (LIM).

 2. Update the Workspace Assembly Service: CustomEventHandler_

LIM.WsAssemblyFactory

 3. On the Application tab go to Workspaces and then your solution configuration 

Workspace. For example, Workforce Planning 1.

 4. Update the Workspace Assembly Service: CustomEventHandler_

LIM.WsAssemblyFactory
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Maintain Assembly
 1. On the Application tab, click Tools > Load/Extract > Extract.

 2. In the File Type drop-down menu, select Application Workspaces.

 3. In the Items to Extract drop-down menu, unselect All.

 4. Click Workspaces > Line Item Modeling > Maintenance Units > Workspace 
Assemblies.

 5. Select CustomEventHandler_LIM.

 6. Click the extract button .

Example
Here is an example method that checks the titles of user-entered data in the Dynamic Grid for an 

empty or Boss value and substitutes them with the Team Leader value.

using OneStream.Shared.Common;
using OneStream.Shared.Wcf;
using OneStreamWorkspacesApi.V800;
using System;
 
namespace Workspace.__WsNamespacePrefix.__WsAssemblyName
{
    public class WsDynamicGridService : IWsasDynamicGridV800
    {
        public XFDynamicGridGetDataResult GetDynamicGridData(SessionInfo si, BRGlobals 
brGlobals, DashboardWorkspace workspace, DashboardDynamicGridArgs args)
        {
            try
            {
                if ((brGlobals != null) && (workspace != null) && (args != null))
                {
                    return Workspace.__
WsNamespacePrefix.LIM.WsDynamicGridController.GetDynamicGridData(si, brGlobals, workspace, 
args);
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                }
                return null;
            }
            catch (Exception ex)
            {
                throw new XFException(si, ex);
            }
        }
 
        public XFDynamicGridSaveDataResult SaveDynamicGridData(SessionInfo si, BRGlobals 
brGlobals, DashboardWorkspace workspace, DashboardDynamicGridArgs args)
        {
            try
            {
                // DO NOT MODIFY THIS METHOD ALL CHANGES SHOULD BE ADDED INSIDE THE 
BEFORE/AFTER EVENT METHODS
 
                if ((brGlobals != null) && (workspace != null) && (args != null))
                {
                    BeforeEvent(si, brGlobals, workspace, args);
 
                    // Insert logic here to save modified rows.
                    XFDynamicGridSaveDataResult result = Workspace.__
WsNamespacePrefix.LIM.WsDynamicGridController.SaveDynamicGridData(si, brGlobals, workspace, 
args);
 
                    AfterEvent(si, brGlobals, workspace, args, result);
 
                    return result;
                }
 
                return null;
            }
            catch (Exception ex)
            {
                throw new XFException(si, ex);
            }
        }
 
        private static void BeforeEvent(SessionInfo si, BRGlobals brGlobals, 
DashboardWorkspace workspace, DashboardDynamicGridArgs args)
        {
            // GET FUNCTION NAME FROM COMPONENT SELECTION CHANGED SERVER TASK ARGUMENTS
            if (args.Component.Name.XFEqualsIgnoreCase("dg_Register_Insert_Delete_LIM"))
            {
                MyCustomBeforeEvent(si, args);
            }
        }
 
        private static void AfterEvent(SessionInfo si, BRGlobals brGlobals, 
DashboardWorkspace workspace, DashboardDynamicGridArgs args, XFDynamicGridSaveDataResult 
taskResult)
        {
            // GET FUNCTION NAME FROM COMPONENT SELECTION CHANGED SERVER TASK ARGUMENTS
            if (args.Component.Name.XFEqualsIgnoreCase("ComponentName"))
            {
                MyCustomAfterEvent(si);
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            }
        }
 
        // PUT CUSTOM METHODS HERE 
        private static void MyCustomBeforeEvent(SessionInfo si, DashboardDynamicGridArgs 
args)
        {
            if (args.SaveDataArgs != null)
            {
                foreach (XFEditedDataRow row in args.SaveDataArgs.EditedDataRows)
                {
                    if (row.InsertUpdateOrDelete == DbInsUpdateDelType.Insert)
                    {
                        var titleValue = row.ModifiedDataRow.Items.ContainsKey("Title") ? 
row.ModifiedDataRow.Items["Title"]?.ToString() : null;
 
                        if (string.IsNullOrWhiteSpace(titleValue) || titleValue == "Boss")
                        {
                            row.ModifiedDataRow.Items["Title"] = "Team Leader";
                        }
                    }
                }
            }
        }
 
        private static void MyCustomAfterEvent(SessionInfo si)
        {
            // ADD CUSTOM AFTER EVENT CODE HERE
        }    
    }
}
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